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Introduction

Introduction

Thank you for purchasing the Inkjet printer Tx330-1800.

Read this operating manual ("this document" hereinafter) thoroughly and make sure you understand its
contents to ensure safe and correct use of the product.

Please note that the illustrations contained in this manual are intended to show functions, procedures, or
operations and may sometimes differ slightly from the actual machine.

Adobe, the Adobe logo, Acrobat, lllustrator, Photoshop, and PostScript are the trademarks or registered
trademarks of Adobe Incorporated in the United States and other countries.

RasterLink and TxLink are trademarks or registered trademarks of Mimaki Engineering Co. Ltd. in Japan and
other countries.

Other company and product names mentioned herein are the trademarks or registered trademarks of the
respective companies in Japan and in other countries.

Unauthorized reproduction of any portion of this document is strictly prohibited.
© 2025 MIMAKI ENGINEERING Co., Ltd.

® DISCLAIMERS

+ MIMAKI ENGINEERING REJECTS ALL LIABILITY FOR DAMAGE ARISING DIRECTLY OR
INDIRECTLY FROM THE USE OF THE Tx330-1800 ("THIS MACHINE" HEREINAFTER), WHETHER
OR NOT THE PRODUCT IS FAULTY.

+ MIMAKI ENGINEERING REJECTS ALL LIABILITY FOR DAMAGE, DIRECT OR INDIRECT, TO
MATERIALS CREATED WHILE USING THIS MACHINE.

* USING THIS MACHINE IN CONJUNCTION WITH DEVICES OTHER THAN THOSE RECOMMENDED
BY MIMAKI ENGINEERING MAY RESULT IN FIRE OR ACCIDENTS. SUCH INCIDENTS ARE NOT
COVERED BY THE PRODUCT WARRANTY. MIMAKI ENGINEERING REJECTS ALL LIABILITY FOR
DAMAGE, DIRECT OR INDIRECT, ARISING FROM SUCH INCIDENTS.

+ USE ONLY GENUINE MIMAKI ENGINEERING INK AND MAINTENANCE LIQUID. USE OF OTHER
PRODUCTS MAY RESULT IN FAILURES OR REDUCE PRINT QUALITY. SUCH INCIDENTS ARE
NOT COVERED BY THE PRODUCT WARRANTY. MIMAKI ENGINEERING REJECTS ALL LIABILITY
FOR DAMAGE, DIRECT OR INDIRECT, ARISING FROM SUCH INCIDENTS.

+ DO NOT ATTEMPT TO REFILL THE INK PACKS WITH UNAUTHORIZED INK. SUCH INCIDENTS ARE
NOT COVERED BY THE PRODUCT WARRANTY. MIMAKI ENGINEERING REJECTS ALL LIABILITY
FOR DAMAGE, DIRECT OR INDIRECT, ARISING FROM SUCH INCIDENTS.

® TV and radio interference

» The machine emits high-frequency electromagnetic radiation while operating. Under certain
circumstances, this may result in TV or radio interference. We make no guarantee that this
machine will not affect special radio or TV equipment.

If radio or TV interference occurs, check the radio or TV reception after turning off the machine. If the
interference disappears when the power is turned off, the machine is likely to be the cause of the
interference.

Try any of the following solutions or combinations of these solutions:
» Change the orientation of the TV or radio antenna to find a position where interference does not occur.
* Move the TV or radio away from this machine.

® FCC (Federal Communications Commission) regulations

The machine has been tested and certified to comply with restrictions applying to Class A digital devices
under Part 15 of the FCC regulations. These restrictions are designed to provide suitable protection from
harmful interference when the printer is used in commercial environments.

This product may generate, use, or emit radio frequency energy and may cause harmful interference with
radio communications if not installed or used in accordance with the operating manual.
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Use of this product in residential areas may cause harmful interference. If so, the user is responsible for
rectifying such interference.

» Use only the cables recommended by Mimaki Engineering when connecting to the machine.
Use of other cables may cause the product to exceed the restrictions stipulated by FCC
regulations. To maintain compliance with FCC regulations, use the cables recommended by
Mimaki Engineering.




To Ensure Safe Use

To Ensure Safe Use

Symbol Marks

This document uses symbol marks to explain precautions when operating the machine. Make sure you fully

understand the meaning of each mark to ensure safe and correct use of the machine.

Explanation

Warning Indicates a potential hazard that may result in death or serious injury
if handled improperly or if instructions are disregarded.

Caution Indicates a potential hazard that may result in minor or moderate
injury if handled improperly or if instructions are disregarded.

Notice Indicates a potential hazard that may result in property damage if
handled improperly or if instructions are disregarded.

Warning sign | Indicates something that requires attention. Warning specifics are

drawn inside the symbol.

Mandatory action
sign

Indicates an action that must be carried out. The specifics of the
mandatory action are drawn inside the symbol.

A
W
O

Prohibition sign

Indicates a prohibited action. The specifics of the prohibited action
are drawn inside the symbol.

Important Indicates important information related to use of this machine.
\Q/ Tip Indicates useful reference information.
Reference Indicates the corresponding page for related information.
@D information




To Ensure Safe Use

Usage Precautions

® In the event of abnormal conditions

/\ WARNING

* In the event of abnormal conditions such as smoke or unusual odor, turn off the main power
z ” 5 immediately and turn off the breaker. Continuing to use the machine under these conditions
may result in failure, electric shock, or fire. Once you have confirmed that smoke is no longer
being emitted, contact your local dealer or our service office. Never attempt to repair the
machine yourself, which is hazardous.

/\CAUTION

« Immediately wipe off any ink, maintenance liquid, waste ink, or other liquid used with the
z ” 5 product that comes into contact with your skin. Then wash using soap, and rinse with plenty of
water. Failure to wash off ink may result in skin inflammation. If your skin becomes irritated or
painful, seek medical attention immediately.

« If ink, maintenance liquid, waste ink, or any other liquid used in the product comes into contact
with your eyes, rinse immediately with plenty of clean water. Rinse for at least 15 minutes. If you
wear contact lenses and they can be easily removed, remove after rinsing for at least 15
minutes with clean water. Be sure to also rinse the undersides of your eyelids. Failure to rinse
off ink may result in blindness or impaired vision. If your eyes become irritated or painful, seek
medical attention immediately.

« If ink, maintenance liquid, waste ink, or any other liquid used in the product enters your mouth or
is swallowed, gargle with water immediately. Do not induce vomiting. Seek medical attention
promptly. Inducing vomiting may cause liquid to enter the airway.

 If a large amount of vapor is inhaled, move to a well-ventilated area, keep warm, and rest in a
posture that allows easy breathing. If the condition does not improve, seek medical attention
promptly.

NOTICE

a + If an ink leak occurs, turn off the main power immediately and turn off the breaker. Then, contact

your local dealer or our service office.




To Ensure Safe Use

® Power supply precautions

/\ WARNING

» Do not damage or modify the power cable. Do not place heavy objects on, heat or stretch it.
Doing so may damage the cable, leading to electric shock or fire.
* Do not use the power cable if it is damaged or broken or if the core wire is exposed. Otherwise

there is a risk of failure, electric shock, or fire.

« Always connect the machine to a switchboard with grounded polarity. Otherwise there is a risk
of failure, electric shock, or fire. All electrical work (Class C grounding work; formerly Type 3
grounding work) must be handled by a licensed electrician.

NOTICE

» Do not turn off the main power supply. Turning off the main power supply will disable the
automatic maintenance function (including nozzle clogging prevention function and ink
discharge channel cleaning function). This increases the risk of ejection failures (such as nozzle
clogging or deflection).

* When connecting the power cable, check the input voltage of the power outlet and the capacity
of the breaker. Also, connect each cable to a separate power source with an independent
breaker. Connecting to power outlets linked with the same breaker will cause the breaker to trip.

0 + Use the machine with a power supply that meets specifications.

10



To Ensure Safe Use

® Caution regarding moving parts

/\CAUTION

» Keep parts of the body such as the face and hands away from moving parts. Also keep clothing
(e.g., loose clothing and accessories) that may impede work away from the machine. Failure to
do so may result in injury.

Long hair should be tied back. Failure to do so may result in injury.

e ®

® Do not disassemble or repair

/\ WARNING

» Do not attempt to disassemble or repair this machine. Otherwise there is a risk of failure, electric
shock, or fire.

® Other usage precautions

/\ WARNING

@ » Keep children away from the machine.
NOTICE

« Do not hold the acrylic part when opening the front cover. Doing so may damage the acrylic.

* Do not pull the media when the clamp lever is lowered (the media is clamped). Doing so may
damage the machine.

« The underside of the media may be soiled depending on how the printed media has been stored
(due to weight when laying printed media rolls horizontally, for example) and the media type.
Perform a test beforehand to check that the media does not transfer ink to the underside of the
adjacent media.

\Q/ » Condensation may form on the print head nozzle surface depending on the ambient

- temperature and humidity. The formation of condensation may cause ejection failures (e.g.,
nozzle clogging or deflection). Perform head cleaning if any ejection failures (e.g., nozzle
clogging or deflection) occur during printing. (25 "Head Cleaning"(P. 96)

® Disposing of the product

/\CAUTION

* When disposing of the product yourself, contact an industrial waste disposal operator or dispose

0 » Please contact your local retailer or service agent.
of the product in accordance with local laws and regulations.

11



Notes on Handling Ink or any Other Liquid Used with the Machine

Notes on Handling Ink or any Other Liquid
Used with the Machine

Precautions regarding ink, maintenance liquid, or other liquids used with this machine are included with the
containers. Thoroughly read them and make sure you understand the contents.

» Be sure to read the safety data sheet (SDS) before use. https://mimaki.com/supply/sds/

O

/\CAUTION

» Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

Do not subject cases containing ink to strong shock or violent shaking. Do not attempt to refill
the ink. Leaking ink may adhere to the skin or get into your eyes or mouth.

* Do not disassemble cases containing ink. Leaking ink may adhere to the skin or get into your
eyes or mouth.

* Do not store ink, maintenance liquid, or other liquids used with the machine in locations where
children may enter.

» When disposing of ink, maintenance liquid or other liquid used with the product, or containers or
non-woven fabric contaminated with ink or other liquid, contact an industrial waste disposal
operator or dispose of the product in accordance with the local laws and regulations.

Se¥rveee

NOTICE

Do not store ink, maintenance liquid, or other liquids used with the machine in locations

exposed to direct sunlight.

* Do not store ink, maintenance liquid, or other liquids used with the machine in environments
where cutting fluid or other volatile substances (such as amines or modified amine alcohol) are
present in significant quantities. Storage in such places increases the risk of failure or ejection
failures (e.g., nozzle clogging or deflection).

» Do not use ink, maintenance liquid, or other liquids used with this machine with other printers.

Doing so may cause failure.

@

Be sure to store them in a low place no higher than 1 m above the floor. Otherwise there is a
risk of scattering if the containers fall.

« Store in tightly sealed containers.

+ Store in a cool, dark place.

©

(1) Store ink in a place where ink does not freeze. Using defrosted ink may deteriorate ink
constituents and reduce print quality.

(2) When ink is moved from a cold place to a warm place, leave it in the environment where
the machine is installed for at least three hours before using it.

(3) Open the container just before installing it, and use it up as quickly as possible. If it is
opened and left for an extended period of time, print quality may be reduced.

12
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Notes on Handling Ink or any Other Liquid Used with the Machine

» Do not touch the metal parts of the ink IC chip. Static electricity may damage the ink IC chip,
and dirt or damage may cause the ink IC chip read error.

 Printing is disabled if a different ink IC chip is used.

13




Notes on Handling Ink or any Other Liquid Used with the Machine

Ink Specifications

Item Tx330-1800
Type Special Sublimation Transfer | Special Dye Sublimation Ink | Special Pigment Trasnfer Ink
Ink Sb411 (Mimaki Sb420 (Mimaki Engineering | TP410 (Mimaki Engineering
Engineering product) product) product)
Color Blue (BL) Blue (BL) Cyan (C)
Magenta (M) Magenta (M) Magenta (M)
Yellow (Y) Yellow (Y) Yellow (Y)
Black (K) Black (K) Black (K)
Light blue (Lbl) Red (R)
Light magenta (Lm) Blue (BL)
Green (GR)
Light black (Lk)
Form Aluminum pack
Ink capacity |2,000 mi
Expiration As indicated on the ink pack. However, after opening, it should be consumed within one
date month, even if before the expiration date.
Stora [Whe |10 to 35 °C (daily mean temperature)
ge n
temp |store
eratu |d
*1
re Durin |0 to 40 °C
g
trans
porta
tion

*1. Ink quality may deteriorate if stored outside this temperature range.

14




Notes on Handling Ink or any Other Liquid Used with the Machine

Restrictions Concerning the Expiration Date of Ink Used in the

Machine

Example: When the expiration date is April 20xx
* May 20xx: Replace with new ink or use up as quickly as possible. Printing is possible.

» June 20xx: Replace with new ink or use up as quickly as possible. Printing is possible.

» July 20xx: Printing is not possible.

>« The message appears on the display.

* The ink expiration date is indicated on the ink containers. Expired ink may cause ejection

failures or alter the color tone. Printing is possible even if the ink has passed its expiration date
Nevertheless, we recommend replacing with new ink or using up as quickly as possible.

15




Installation Precautions

Installation Precautions

/\ WARNING

» Do not install the machine in a place close to fire.

» Do not place flower vases, pots, cups, containers containing cosmetics, chemicals or water, or
small metal items on or close to the machine. If they enter the machine, there is a risk of failure,
electric shock, or fire.

» Do not install this machine in humid locations or locations where it may be exposed to splashing
water. Otherwise there is a risk of failure, electric shock, or fire.

Do not install the machine in a place where children may enter.

/\CAUTION

+ A ventilation system must be provided if this machine is installed in a poorly ventilated area or
sealed room.
» Be sure to observe the following points when installing an extractor outlet:

of®e

(1) The extractor outlet must be installed in accordance with applicable local EHS
(environmental, health, and safety) guidelines.

(2) If the extractor outlet is fitted with a shutoff valve, the valve must be open when this
machine is in use.

NOTICE

* Do not install this machine in locations where dust or powder is present. Failure or printing
defects may result (e.g., nozzle clogging, deflection) if dust gets inside this machine.

» Do not install this machine in locations exposed to drafts (e.g., from air conditioning).
Disregarding this precaution may result in dust or powder getting inside this machine.

» Do not install this machine in unstable locations or locations subject to vibration. This will
increase the risk of failure or printing defects (e.g., nozzle clogging, deflection).

» Do not install this machine in locations exposed to direct sunlight.

* Do not install this machine in locations subject to sudden temperature changes. This will
increase the risk of failure or printing defects (e.g., nozzle clogging, deflection).

» Do not install this machine in locations exposed to excessive noise from large machinery.

» Do not install this machine in locations where photographic fixing agents generate vapor or acid
gas (e.g., acetic acid, hydrochloric acid) or locations filled with metal working fluids or highly
volatile substances (e.g., amines, amine-modified alcohols). Malfunctions or printing defects
may result (e.g., nozzle clogging, deflection) as print head ink is more likely to harden under
such environments.

» Operating environment: 20 to 30 °C (68 to 86 °F), 35 to 65 %RH (no condensation)
» Temperature range in which accuracy is guaranteed: 20 to 25 °C (68 to 77 °F)

16



Installation Precautions

Installation Space

Provide the following space around the machine to allow safe and proper replacement of ink and media:

® Tx330-1800

Size Tx330-1800

Width "’ At least 4,230 mm (3,230 mm)

Depth At least 2,965 mm (965 mm)
P *9

Height (1,857 mm)

Weight 291 kg

*1. The figures in parentheses indicate machine dimensions.
*2. With ink eco-cases loaded.

When Relocating This Machine

Contact your local dealer or our service office. Attempting to handle relocation yourself may result in failure
or damage.

17



Safety Interlocks

Safety Interlocks

The machine is equipped with interlocks to ensure safety during use.

Printing will abort if you open the covers while printing is underway. The RIP data will need to be resent.

» Safety interlock locations

18



Warning Label

Warning Label

Make sure you fully understand the details indicated on the various warning labels.

If any of the warning labels becomes dirty and illegible or peel off, contact your local dealer or our service

office to request new warning labels.

19



Warning Label

No. [ Order code Details
1 M910931 COVER HAZARD Beware of opening and closing
May result i . .
parts. Injury may result if hands
become trapped.
COUVERCLE-DANGER
Peut entrainer de graves
blessures.
Lors de l'ouvertu u de la
fermeture du couvercle,
tenir le couvercle jusqu'a la
M910931
2 M907833 Indicates dangerous moving parts.
3 M903330 Wear safety glasses and gloves
while working.
4 M905811 E [ A== [awasne [anmomel anmsaar]| | Indicates dangerous moving parts.
FERSAANRLE | BB o o | SEVEGUCHE Tee  [oRvGEROSES
R, WRBARR | RREESHONOR body pars away. Korpertele fornhalten. w;pnnnlhoudepnme,
5 M907935 f Indicates dangerous live parts.
6 M918910 j Indicates dangerous moving parts.

20
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Chapter 1 Before Use

1.1 Part Names and Functions

No. Name Overview

1 | Ink Supply Unit Each tank contains an ink of a particular color. (25 "Ink Supply Unit"(P. 25)

2 |Platen Print area. & "Platen"(P. 26)

3 | Pinch roller The pinch rollers and grit rollers are used to grip and feed the media. (&&°

Grit roller "Pinch Rollers and Grit Rollers"(P. 27)

4 | Front cover Open the cover to load media, perform maintenance near the platen, or
replace consumables. Printing and automatic maintenance are not possible
while the covers are open.

5 [Maintenance cover Open the cover to perform maintenance on locations such as the carriage
underside. Printing and automatic maintenance are not possible while the
covers are open.

6 |[Carriage Consists of components such as the print head and jam sensor. &~
"Carriage"(P. 26)

7 | Operating Panel Includes operating keys and displays indicating various settings and other
items. (&5 "Operating Panel"(P. 30)

8 | Station Includes caps and wipers for protecting print heads. (& "Station"(P. 26)

9 |[Clamp lever Lowering the clamp lever secures the media. Raising the clamp lever
releases the media. Linked to the clamp lever at the rear.

10 | Waste Ink Tank Container for waste ink. &~ "Waste Ink Tank Replacement"(P. 158)

11 | Media Edge Guides In some cases, roll media may shift sideways and start to curl inwards.
Using the media edge guides prevents the roll media from becoming offset.
(& "Using media edge guides"(P. 69)

12 | Take-up unit Rolls up the printed roll media. & "Take-up unit"(P. 62)

13 | Tension roller Roller for feeding the media. (" "Preparing the Tension Roller"(P. 58)
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No. Name Overview

14 | Cloth-wound roller Helps keep cloth media clean by removing any ink on the tension roller. <&~
"Setting Up the Fabric Roller"(P. 59)

15 | Platen holder Used to store the platen detached when printing on cloth media. &&° "Platen
holder"(P. 27)

16 | Take-up reversing bar

Stabilizes tension of wound media.(®&” "Adjusting the reversing bars"(P. 79)

17

Take-up tension bar

Adjusts tension of wound media. & "Using the tension bars"(P. 71)
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Rear and Right Side View

No. Name Overview

1 | Clamp lever Linked to the clamp lever at the front.

2 | Media Sensor Detects whether media is present. & "Media Sensor"(P. 28)

3 | Blowing fan Blows air to dry ink after printing. <& "Blowing Fan Filter
Replacement"(P. 150)

4 | Exhaust fan box Discharges air for holding down the media.

Feeding reversing bars | Stabilizes feeding tension of media. & "Adjusting the reversing
bars"(P. 79)

6 |Feeding tension bar Adjusts feeding tension of media. & "Using the tension bars"(P. 71)

7 | Feeding unit Feeds roll media to the front of the machine. (& "Feeding unit"(P. 70)

8 | Maintenance liquid Used to automatically feed maintenance liquid to the cap, and to prevent ink

cartridge solidifying inside the ink discharge channel during maintenance.

9 | USB port Connects to PC via a USB interface cable. & "Using a USB Cable"(P. 37)

10 | LAN port Connects to PC via a LAN cable. " "Using a LAN Cable"(P. 36)

11 | Main power switch The main power supply for the machine. To prevent ejection failures
attributable to the print head (e.g., nozzle clogging or deflection), do not turn
off the main power supply. & "Power Supply Switch"(P. 29) & "Turning
On the Power"(P. 33) (&&° "Turning Off the Power"(P. 34)

12 |AC inlet Use the power cable provided. (& "Connecting the Power Cable"(P. 33)
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No. Name Overview
1 |Ink Eco-case The ink eco-cases are mounted here. & "Mounting the ink"(P. 45)
2 |Ink lever Push down the lever to remove the ink eco-cases.
3 |[Ink IC chip slot Insert the ink IC chips provided with the ink. This manages the ink
information.
4 |Ink leak check tube When ink is in the tube, contact your local distributor, our sales office, or

service center. .
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Carriage

The station includes a cap for preventing the print head nozzle surface from drying out, and a wiper required

The carriage includes a print head for ejecting ink, and a jam sensor for stopping the carriage when media
for print head maintenance.

clogs. Printing occurs as ink is ejected while traversing left and right.
When printing on paper media, platens are used to secure the media under vacuum pressure. & "When

using paper media"(P. 53)
Remove the platens when printing on cloth media. &~ "When using cloth media"(P. 52)
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Platen holder

When printing on cloth media, the platen is removed and stored in the platen holder.

===
[Platen storage location]
]

Pinch Rollers and Grit Rollers

The pinch rollers and grit rollers are used to grip and feed the media.

rollers.
» Leaving the pinch rollers lowered may cause them to become deformed and prevent media from
being fed correctly.
» Leaving media loaded will subject it to force from the pinch rollers, which may leave pinch roller
marks on it.

0 When the machine is not in use, raise the clamp lever to separate the pinch rollers from the grit

~ v °* Attach the clamp changeover sliders to the pinch rollers at the left and right-hand ends of the

g media. The pinch rollers can be raised by attaching clamp changeover sliders. (Do not raise
pinch rollers other than those at the left and right edges of the media.) This prevents gripping
the left and right-hand ends of the media for consistent feeding.

Clamp changeover
slider
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Media Sensor

The media sensor detects the presence/absence of media. The sensor must be covered by the media to
detect the media width. Two sensors are located on top of the pre-cover (at the rear).

[Rear view] : \

Media Sensor
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Power Supply Switch

® Main power switch

This is located at the rear on the right-hand side of the product.

/>
/;

2|

Main power switch

* Do not turn off the main power supply. Turning off the main power supply will disable the
automatic maintenance function (including nozzle clogging prevention function and ink

discharge channel cleaning function). This increases the risk of ejection failures (such as nozzle
clogging or deflection).

/>

® [END/POWER] key

The [END/POWER] key is the key normally used to turn the power on and off.

To turn off the power, hold down the [END/POWER] key. Press the [ENTER] key once the instructions
appear on the display.
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Operating Panel

This is used to control the product and make/change settings.

No. Name Overview

1 | Display (& "Display"(P. 31)

2 |[SEL] key Selects the function for the corresponding [FUNCTION] key.

3 |[FUNCTION] key |Used for test printing, head cleaning, and editing settings. & "[FUNCTION]

key"(P. 32)

4 |[JOG] key Used to move the carriage, feed media, and select settings
®OO®
5 |[END/POWER] Used to cancel the last setting entered, return to the previous level of the setting
key menu, or to turn power on and off
* llluminates in blue when the power is on. (& "Turning On the Power"(P. 33)
* To turn off the power, hold down the key. (2" "Turning Off the Power"(P. 34)
6 |[ENTER] key Used to move to the next level menu and to confirm settings. This can also be
used to display product information. (22~ "Displaying Machine Information (Local
Guidance)"(P. 32)
7 | Status lamp This lamp indicates the machine status.
Off Indicates LOCAL mode. Used for test printing, maintenance,
and settings
Light | lllumina | Indicates REMOTE mode. The product is in standby to receive
blue ted print data.
Flashin | Indicates that printing is in progress. This also flashes to
g indicate test printing—for example, when printing built-in
patterns.
Blue | lllumina | Indicates that data remains to be printed. Switch to REMOTE
ted |mode and start printing
Green | Flashin [ Indicates that maintenance is underway. Some functions will
g be limited until maintenance has ended.
Yellow | Flashin | Ink Near End status (very little ink remains). @& "When Ink
g Near End is Displayed"(P. 41)
Red | Flashin | An error has occurred. Refer to the error code list and take
g appropriate action. & "Error Message"(P. 171)
lllumina | A system error (SYSTEM HALT) has occurred. Contact our
ted |service office. @& "SYSTEM HALT"(P. 177)
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Display

Head height— & LOW i ED 1620mm —Detected media width
L= 4 L

. _Function name assigned to
b [FUNCTION] key

MENU mode
Four menu modes are available.
Name Overview
LOCAL mode Used for test printing, maintenance, and settings
REMOTE mode Prints the print data received from a PC.
MENU mode Press the [MENU] on the LOCAL mode screen to switch to MENU
mode. This is used to set various functions.
NOT-READY mode Status before media is detected
Ink status

The ink pack status such as remaining ink levels and ink errors are indicated by icons.

Icon Overview

@ Displays remaining ink levels using a 9-stage icon.

O 0 | & | & | € | 6| % | X

Full 1/8 used | 1/4used | 3/8used | 1/2used | 5/8 used | 3/4 used | 7/8 used

e Very little ink remains. Prepare fresh ink.

Printing is not possible. Displayed when ink is depleted or an ink error has occurred. (& "Ink
Error"(P. 170)
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[FUNCTION] key

This section describes the functions and roles assigned to the [FUNCTION] key.

Icon Overview

Displays the various menu screens. & "Setup"(P. 107)

s | Displays maintenance functions such as test printing and cleaning.
CLEANING

Switches from LOCAL mode to REMOTE mode.

Displays adjustment functions such as feed adjustment and drop position adjustment.

Displays the Heater Temperature Setup screen.

DATA CLEAR Clears received data.

Used to switch from REMOTE mode to LOCAL mode

Used to move to the previous menu screen

Used to move to the next menu screen

\'4
\'%

Used to close the confirmation screen in response to prompts or other messages

Used to disable functions

Indicates that the function is assigned. Displays settings and functions.

Used to enable or disable multiple items

Displaying Machine Information (Local Guidance)

Press the [ENTER] key on the LOCAL mode screen to display the following information.
* Ink information: Displays ink type, remaining ink levels, and ink errors.

* Information: Displays information such as media width, head height, product serial number, firmware
version, command version, and LAN connection status.
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1.2 Connecting the Power Cable

1 Check to confirm that the main power supply is turned off.
2 Connect the cable band to the machine.
3 Connect the power cable to the inlet of the machine.

4 Secure the power cable to the cable band.

» Pass the power cable through the clamp and clamp until it clicks into place.

Power cable

C

Cable band ——

/

5 Plug the power plug into the power outlet.

Power plug

——Power outlet

é » Do not handle the power plug with wet hands. Disregarding this precaution may result in
electric shock.

Turning On the Power

1 Check to confirm that the main power supply is turned on.

+ If the main power supply switch is not turned on, set to

/>

S
=

Main power switch
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2 Press the [END/POWER] key to turn on power.

» The firmware version appears on the display, and the initial operation is executed. The machine
will then enter the Media Select mode, and is ready for use.

3 Turn on the power for the connected PC.

automatic maintenance function (including nozzle clogging prevention function and waste ink
draining channel cleaning function). This will increase the risk of failure or ejection failures (e.g.,

nozzle clogging or deflection).

0 » Close the front cover and maintenance covers. Leaving any of the covers open will disable the

Turning Off the Power

» Check the following when turning off power:
(1) The front cover and maintenance covers are closed.

* Leaving any of the covers open will disable the automatic maintenance function (including
nozzle clogging prevention function and waste ink draining channel cleaning function).

(2) The carriage has returned to the capping station.

« If not, the print head nozzle may dry out, resulting in ejection failures (such as nozzle
clogging or deflection).

(3) Data is not being received
(4) No errors have occurred.
« (" "Problems Causing Messages to Appear"(P. 168)

1 Turn off the power to the PC connected.

2 Hold down the [END/ POWER] key.

» A power off confirmation screen appears. Press the [ENTER] key to turn the power off.
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automatic maintenance function (including nozzle clogging prevention function and ink
discharge channel cleaning function). This increases the risk of ejection failures (such as nozzle

clogging or deflection).
63
&

® * Do not turn off the main power supply. Turning off the main power supply will disable the
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1.3 Connecting a PC to the Product

Connect the machine to the RIP PC. The following cables can be used:
1. & "Using a LAN Cable"(P. 36) (Recommended)
2. & "Using a USB Cable"(P. 37)

When using the USB cable
» Data may be transferred to the machine too slowly, causing the carriage to pause at the left-
hand or right-hand end during printing.

Using a LAN Cable

Connect a PC to this product using a LAN cable. Insert a LAN cable until it engages with a click.

® + Do not unplug the cable while data is being transferred.

® Network Connection Precautions
Make sure the network is set up as follows: Printing is not possible if the network is not set up correctly.
» Use a Category 6 or higher LAN cable.

» The PC used to transfer print data must be located on the same network as this product. This product
cannot be connected via a router.

* Use a 1000BASE-T compatible computer or switching hub. Printing requires 1000BASE-T support.

® Checking the LAN connection

1 Check the display on this product.

« Local guidance can be used for checking. (22 "Displaying Machine Information (Local
Guidance)"(P. 32) Printing is not possible if "100Mbps", "10Mbps", or "No Connect" is displayed.

INFORMATION

LAN Status 1000Mbps

m

2 Check the lamp on the LAN connector.

» The LAN connector lamp illuminates when the machine is running.

L]
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Color Status Overview
Green llluminated Connected via 1000BASE-T
Off Connected via a network other than 1000BASE-T
* 1,000 Mbps is not supported if only the orange lamp is illuminated or
flashing. Check the specifications for the PC, peripheral devices, and
cable.
Orange llluminated Linked up (connected).
Flashing Data being received
Off Link down (not connected)

Using a USB Cable

Connect a PC to this product using a USB interface cable.

® * Do not unplug the cable while data is being transferred.

0 « Use RIP software that supports the USB interface.

\ /

\g/ « If the computer has no USB port, contact your local dealer or our service office.

When using the USB cable
» Data may be transferred to the machine too slowly, causing the carriage to pause at the left-
hand or right-hand end during printing.

® USB Connection Precautions

* When connecting more than one Tx330-1800 to a PC

— If the PC has more than one USB port, try connecting to a different USB port to check whether the
product is correctly recognized. If the product is still unrecognized even when connected to a
different USB port, use a commercially-available USB active repeater cable.

* When extending the USB cable

— Use a commercially-available USB active repeater cable. However, make sure that the combined
length of the USB cable and the USB active repeater cable does not exceed 20 m.

— If the USB cable is extended, this may reduce the data transfer speed to the machine, causing the
carriage to pause at the left-hand or right-hand end during printing.

» USB high-speed mode peripheral devices

— It may not be possible to recognize USB peripheral devices if USB high-speed mode peripheral
devices (e.g., USB memory, USB HDD devices) are connected to the PC to which the product is
connected. If external USB hard disk drives or other similar devices are connected, this may reduce
the data transfer speed to the machine, causing the carriage to pause at the left-hand or right-hand

end during printing.

» Unplugging USB memory devices

— When unplugging USB memory devices from the PC to which this product is connected, use "Stop"
in "Safely removing hardware" before unplugging. Otherwise, an [ERROR 201 Command Error] will
occur.
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1.4 System Configuration

Use RIP software to request to print data created using applications like Illustrator or Photoshop.

RIP-PC

mﬂ P
Receiving Print Data Sofitwalie
v;; 2

Generating RIP Data

I |
I |
I |
I |
I |
| [Ethernet connection] |
I |
I |
I |
I |
I |
I |

[Local network]

___________________ R — |
Preparing RIP Data
Print request
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Installing the Mimaki Driver

1 Download the Mimaki driver from our website.

+ https://mimaki.com/download/inkjet.html
[Tx330-1800] > [Driver/Utility]

2 Install the MIMAKI driver.

Installing RIP Software

The explanation here applies to MIMAKI RIP software (RasterLink).

+ If using TxLink, refer to the TxLink operating manual.

1 Install RasterLink.

» The following icon appears on the PC desktop once the software has been installed.

oster
Link

o A7

@ » For more information, refer to the RasterLink installation guide. https://mimaki.com/download/

software.html

\Q/ * Once installed, activate the license for Rasterlink. Otherwise, "Profile Update" will not start.

Obtaining Color Profiles

Print quality (e.g., tone, bleeding) will vary depending on the media and ink set. To maintain consistent print
quality, select a color profile that suits the media and ink set.

» The RasterLink Series includes a function allowing color profiles to be downloaded and installed directly
from the Internet. For more information, refer to "Installing Profiles" in the RasterLink Series installation
guide.
https://mimaki.com/download/software.html
[RasterLink Series used] > [Manuals]

* Color profiles for Mimaki RIP software (RasterLink) are available on the Mimaki website.
https://mimaki.com/download/inkjet.html
[Tx330-1800] > [Profile]

Setting Up RIP Software

The explanation here applies to MIMAKI RIP software (RasterLink).

« If using TxLink, refer to the TxLink operating manual.

1 Launch RasterLink.

* The [Printer Management] screen appears.
» To add a new model, launch RasterLink, then select [Environment] > [Printer Management].


https://mimaki.com/download/inkjet.html
https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
https://mimaki.com/download/inkjet.html
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2 Register Tx330-1800.
(1) Click [Add].

Printer Management

No. | Printer Name | Model | Color | Dutput Port | Cuttermodel ... | Output Port

Delete Cutter device registe Function icon Properties

Close

(2) Set the specifics for Tx330-1800.

%) Printer Settings x

Sublimation420 BMYK

Unused

Output Port
File

Printer Name | T5330-3200D5
Prolie Maagemest Cancel

* Model: Select the model.
For models using normal ink sets, select [Tx330]. For models using
hybrid ink sets, select [Tx330-Hybrid].

» Color: Select the ink set filled.
» Output Port: Select the cable connected.
» Available Printers: Select Tx330-1800 connected.
* Printer: Enter a name as required.
(3) Click [OK].
» A confirmation screen appears.
(4) Click [Yes].
* Printer registration starts.

» For more information, refer to the RasterLink installation guide. https://mimaki.com/download/
software.html
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1.5 Ink Replacement Method

Ink levels are low. We recommend replacing with new ink as soon as possible, because the ink packs are
nearly empty. Printing is still possible but continuous printing is not, and some maintenance functions such
as cleaning are disabled. Note that ink may run out during printing.

To check which color ink needs to be replaced, press the [ENTER] key on the LOCAL mode screen. (&°
"Displaying Machine Information (Local Guidance)"(P. 32)

When Ink End is Displayed

The ink has run out. Replace with new ink.

Thoroughly read the following and make sure you understand its contents.
& "Notes on Handling Ink or any Other Liquid Used with the Machine"(P. 12)

) » Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking

ink may adhere to the skin or get into the eyes or mouth.
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Replacing Ink

Ink replacement procedure

® Removing Ink Eco-cases

1 Push down the lever on the pedestal, and remove the ink Eco-case.

/\4

3 Remove the ink IC chip.

42



Chapter 1 Before Use

4 Wipe off any ink adhering to the ink eco-case opening.

» Check to confirm no foreign matter such as dust or paper towel matter is adhered to the
opening. If foreign matter is present, this may block the ink path and lead to leakage.

-+ We recommend replacing the ink absorber each time you replace the ink pack, to prevent dirt
’g‘ building up on the pedestal of the ink supply unit.

or paper towel to which ink or other liquid is attached, contact an industrial waste disposal

0 * When disposing of ink, maintenance liquid or other liquid used with the product, or the container
operator or dispose of the product in accordance with the local laws and regulations.

® Preparing the Ink

1 Pull out the ink pack and ink IC chip from the ink package.

Ink IC chip

Ink pack
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2 Shake the ink pack to the left and right slowly at least 20 times.

» Shake the bottle slowly from left to right to ensure that the ink moves inside, holding the ink pack

opening with a paper towel.
Repeat /\

» When using an ink pack with ink remaining, hold a paper towel over the ink eco-case
opening and shake slowly with the ink eco-case tilted upright.

3 Remove the seal attached to the ink pack opening.

* Remove the seal completely. If any parts of the seal remain, ink may leak when the ink
eco-case is removed from the base.

No goodpiirh thi‘s par

4 Place the ink pack inside the ink eco-case.

» Push the ink pack connector into the ink eco-case slot. Ink may not be supplied if the connector is
out of position.

» Position the pack as indicated on the label on the ink eco-case.

5 Close the ink eco-case gently to avoid pinching the ink pack.

‘! » Be careful to avoid catching your hands or fingers.
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® Mounting the ink

The order of the ink eco-cases to be set varies depending on the ink set you are currently using. Check the
ink slot numbers, then insert the correct color ink eco-cases.

Ink set Ink positions

1 2 3 4 5 6 7 8
Sb420 (4-color) M M Y Y BL BL K K
Sb420 (6-color) M LM Y LBL BL BL K K
TP410 (4-color) M M C C K Y K Y
TP410 (8-color) M R C BL Lk G K Y
Sb411/Sb420 Sb411 Sb420
(4-color, hybrid) M v BL K M v BL K
Sb411, Sb420/TP410 Sb411, Sb420 TP410
(4-color, hybrid) M Y BL K M c K Y

1 Set an eco-case on the base.

/\
o  Fully push in the eco-case. Otherwise, ink may not be fed properly.
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2 Insert the new ink IC chip into the ink IC chip slot.

* Insert the ink IC chip with the metal side facing up. Inserting it in the wrong way may
cause failure of the machine or damage the ink IC chip.

» Do not touch the metal parts of the ink IC chip. Static electricity may damage the ink IC
chip, and dirt or damage may cause the ink IC chip read error.

* Ink IC chips: The marking on the ink IC chip indicates the color information.

Marking location

Ink Color Marking
Cyan @ (One biue circle)
Magenta . (One red circle)
Yellow () (One yellow circle)
Black @ (One black circle)
Light cyan .. (Two blue circles)
Light magenta .. (Two red circles)
Light black o0 (Two black circles)
Orange Q (One orange circle)
White () (One white circle)
Blue o0 (One blue circle/one red circle)
Light blue Q@O ® (1.0 biue circles/one red circle)
Red .O (One red circle/one yellow circle)
Green

. (One green circle)

* Insert the ink IC chip included in the package with the ink. The ink IC chip stores information
such as the ink color, remaining amount, and expiration date. Printing is not possible if an
incorrect ink IC chip is inserted.
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Chapter 2 Printing

2.1 Print Process

1 . Attaching or Removing the Platens

(& "Attaching or Removing the Platens"(P. 51)

2 . Attaching the Ink-Receiving Pan Spacers

(& "Attaching the Ink-Receiving Pan Spacers"(P. 54)

\Q/ + This is performed when printing on cloth media.

3_ Turn on the power.

& "Turning On the Power"(P. 33)

[END/POWER] Key/ ;

/ooss
OO o

4_ Connect a RIP PC to the machine.

(& "Using a USB Cable"(P. 37)
& "Using a LAN Cable"(P. 36)

B . setting Up RIP Software

& "Installing RIP Software"(P. 39) (required first time only)
& "Obtaining Color Profiles"(P. 39)
& "Setting Up RIP Software"(P. 39) (required first time only)

©. Adjusting Print Head Height
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Adjust the height adjustment lever to suit the media. & "Adjusting Print Head Height"(P. 56)

7_ Prepare the tension roller.

& "Preparing the Tension Roller"(P. 58)

\Q/ « This is performed when printing on cloth media.

Setting Up the Fabric Roller

" "Setting Up the Fabric Roller"(P. 59)

\Q/ + This is performed when printing on cloth media.

9_ Loading the Media

This machine can be used with roll media and leaf media. & "Loading the Media"(P. 61)

1 0_ Check the state of the print head nozzles.
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& "Test Printing"(P. 94)

Good example Bad example

A\ y)

x> x x x x x

L]
L]
L]
L]
L]
L]
L]
L]
°
[ ]
L]
L]
L]
a

Nozzle Deflection Nozzle clogging

1 1 . Clean the head to clear malfunctioning nozzles.

There are three different head cleaning methods. Choose the head cleaning method based on test print
results. & "Head Cleaning"(P. 96)

1 2_ Adjust the media feed amount.

& "Feed Correction"(P. 97)

Second band Good example Bad example

______________________________________________________

_______________________________________________________

|
First band

000000 OCGOOS

1 3_ Adjust the drop position for bi-directional printing.

& "Correcting the Drop Position"(P. 99)

+4—0
Medlafeeddlrectlon

In this case, the drop position correction value will be "+4

1 4_ Preparing RIP data

& "Preparing RIP data"(P. 101)

15. Printing RIP data

& "Printing"(P. 103)
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2.2 Attaching or Removing the Platens

The Tx330-1800 supports printing on both cloth media and paper media (decalcomania paper). Attach or
remove the platens to suit the media being used.

A\

Be sure to turn off the main power supply before attaching or removing the platens.
Be sure to clean the platens before removing if they are dirty.
Take care to avoid getting ink on your hands or clothes.

.

If the media is already loaded, first remove the media before attaching or removing the platens.

\ /

:gi )

When using cloth or transfer paper that does not bleed through, set the platens for use with
paper media. @& "When using paper media"(P. 53)

Holding the platens

» The platens consist of thin sheet metal. Wear gloves and take care to avoid cutting your hands.
« Take care not to hit other people or objects when carrying the platens.

Hold the platens with two hands in the center at least 900 mm part.

Hold the platens raised 90 degrees forward from when they are attached flat on the main unit.

Not Acceptable

Holding at only one end Holding at only one point in center
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When using cloth media

When using cloth media, remove the platens and use ink-receiving pan spacers.

® Procedure
1 Open the front cover.

2 Remove the left and right media holders from the platen (one on each side).

<
IS

-

3 Lift up the platens.
» The platens are firmly secured with magnets. Lift up from the platen attachment and removal
section as follows:
(1) Insert the platen removal jig provided between the platen attachment and removal section and
the platens.

[Platen removal jig insertion positions]

(2) Use the platen removal jig to push up and lift the platens from the platen attachment and
removal section.

é » Take care when lifting the platens, as they are secured with magnets, and may spring up.
» Do not use excessive force when inserting the platen removal jigs. Doing so may damage

parts.

4 Pull the raised platens forward to remove them from the platen attachment and removal
section.

5 After removing them, store the platens in the platen holder underneath. (& "Platen
holder"(P. 27)&" "Holding the platens"(P. 51)

6 Attach the left and right cloth holders (one on each side).

N
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When using paper media

When using paper media, remove the ink-receiving pan spacers and install the platens.
® Procedure
1 Open the front cover.

2 Remove the left and right cloth holders (one on each side).

» Move toward the maintenance space to remove them.

» Remove the ink-receiving pan spacer, if fitted.

Remove the platens from the platen holder. (22" "Platen holder"(P. 27)" "Holding the
platens"(P. 51)

Align the end of the platen with the right edge of the platen attachment and removal section,
butted against it.

Align the pin at the end of the platen with the groove on the platen attachment and removal
section and fully insert it.

Attach the left and right media holders (one on each side) to the platens.

P W N

o O A~ W

N\
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Q » Take care to ensure that no paper scraps or threads are trapped when pushing the
platens up flush.
* Remove any paper scraps or threads before proceeding.
» Take care not to trap your fingers when attaching the platens, as the magnets are
powerful.
* Install carefully, so that the media holders do not get caught.

+ Clean the platens after installation if they are dirty. (& "Platen and Platen Wire

o » Check to confirm that the platens are securely installed and do not lift up.
Cleaning"(P. 135)
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2.3 Attaching the Ink-Receiving Pan
Spacers

\g/ » This is performed when printing on cloth media.

» Be sure to attach the ink-receiving pan spacers to prevent the media from being made dirty by
the ink mist when printing.

® Information about the ink-receiving pan spacers
Two types of ink-receiving pan spacers are provided as standard.
* Ink-receiving pan spacer 1 (650 wide x 2, 130 mm wide x 5)

™ n
Py
@]
pd
! =

SIDE VIEW

* Ink-receiving pan spacer 2 (650 wide x 2, 130 mm wide x 5)

FRONT

t

4_U——% =

SIDE VIEW
\

~ * When printing on media with a coarse texture (mesh media) in a low-humidity (35 %RH or less)
’g‘ environment, use the ink-receiving pan spacer 2.

Note the following when using the ink-receiving pan spacer 2:
» Keep the media tensioned, to avoid ink adhering to the underside.
» Use the tension bar and tension roller.
» The media may sag if it comes into contact with the tension bar, causing ink to adhere to the
underside.
« When removing prints, use the (¥) key or white space function to feed the media out first.
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® Ink-receiving pan spacer attachment and removal procedure

1 Move the cloth holders to the left and right sides.

2 Attach the ink-receiving pan spacers.

» Determine how many ink-receiving pan spacers to attach based on the width of images to print.

~

\ /

-~ Guidelines for attaching the ink-receiving pan spacers
+ Select so that the width of the ink-receiving pan spacers is not narrower than the width of the
image being printed.
» Adjust the number of spacers to ensure a margin of at least 10 mm from both the left and right
edges of the image.
« If overprinting, lay out the ink-receiving pan spacers so that they extend beyond the width of the
media.
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2.4 Adjusting Print Head Height

Adjust the height of the print head according to the thickness of the media you are using.

0  Be sure to correct the dot position after altering the print head height. & "Correcting the Drop

Position"(P. 99)

« With inkjet printers, if the gap between the print head and media increases, the ink droplets tend
to vaporize before they reach the media. Vaporized ink may adhere to the print head nozzle
surface and media, affecting print quality and causing failure of the print head. Adjust the print
head height to suit the media.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

» The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]

key.

» The carriage moves over the platen.

3 Open the front cover.

4 Use the height adjustment lever to adjust the height.

» Set the height adjustment lever so that the desired height is at the top. If the lever is not
set to the correct position, problems such as media jamming and misting may occur,
resulting in impaired print quality.

* When doing this at High, be careful not to push the lever too far to the rear.

High .__ D
Middle-High - ==
Middle

. Print head
R (1) Gap between print head and (2) Recommended
2008 platen media thickness i‘/
High 7.0 mm 3.5 mm to 5.0 mm Media Ll _______
Middle-High 6.0 mm 2.0 mm to 4.0 mm
; [
Mldd.le 5.0 mm 1.0 mm to 3.0 mm | Platen
Low-Middle 4.0 mm 2.0 mm or less
Low 3.0 mm (default setting) 1.0 mm or less

5 Once adjustment is complete, close the cover, then press the [ENTER] key.
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» Check the head height indicated on the display. Readjust the height using the height
adjustment lever if it is not at the set height.

SETUP 1

Head height— - LOW 7 B 1620mm

...........
35°/40° 40°/40° OFF
[oJoJo]oJojolo]o)

REMOTE
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2.5 Preparing the Tension Roller

M« Thisis performed when printing on cloth media.

:gi

Adjusting the torque limiter

The tension roller is fitted with a torque limiter. Turn the torque limiter adjustment nut to adjust the force with
which the roller turns.

Torque limiter

Min Mid (recommended) Max

Adjustment nut

L—

Torque scale

» Clockwise: Increases the tension (thicker media)
» Counterclockwise: Reduces the tension (lighter media)

+ If the torque limiter adjustment is too weak, the media will tend to meander and print quality will

be reduced.
« If the torque limiter adjustment is too strong, this may cause wrinkling in some media and print

quality will be reduced.

L If the tension roller spins when the media is loaded
Y= - The torque limiter adjustment is too strong. Either weaken the torque limiter or increase the

weight of the tension bar.

0 * The tension roller torque limiter should be set to "Mid" when printing on cloth media.
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2.6 Setting Up the Fabric Roller

When printing on to coarse cloth, ink remaining on the back of the cloth may adhere to the tension roller and

dirty the cloth media.
Attaching the fabric roller helps to prevent the cloth media from becoming dirty by removing any ink adhering
to the tension roller.

» The fabric roller is not shipped with cloth wound on it. Prepare suitably absorbent cloth that
meets the following conditions.
+ Adjust the length etc., to suit the cloth used. (Make sure that the fabric roller is in contact with
the tension roller at the center and ends.)

(1) Material: Cotton jersey, cotton broadcloth, etc.
(2) Size: 195 cm x 70 cm (approximate)

1 Remove the fabric wound roller.

* The fabric roller is located below the tension roller.

~

Cloth-wolmdm”er\
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2 Wind cloth around the fabric roller.
(1) Align the cloth with the roller.

\ =
— ‘/

Cloth-wound roller

10c®

(2) Secure the cloth to the roller with adhesive tape.

(3) Wind the cloth around the roller, then secure with adhesive tape.

o

3 Attach the fabric roller with the cloth wound on it.

* Mount the fabric roller in the groove below the tension roller.

» Adjust the positions of the bearings at both ends of the fabric roller.

Loosen the screws on the bearing, then adjust so that the fabric roller makes contact with the
tension roller.

——

Cloth-wound rolle /74 l\DJ?J

» Clamp in place so that the fabric roller is in contact with the tension roller at the center and
both ends.

If the rollers are not in contact at the center and both ends, the size of the cloth wound on
to the fabric roller should be changed accordingly.

4 Rotate the tension roller by hand to confirm that it turns smoothly.

+ If the tension roller does not turn smoothly, check the mounting position of the fabric roller.
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2.7 Loading the Media

» Adjust the head height before loading media. Moving the carriage after the media has been
loaded may result in the print head coming into contact with the media and being damaged.

® Media handling precautions

\Q/ » Use Mimaki-approved media to ensure consistent high-quality printing.

/\ WARNING

+ Assign at least two persons to load roll media. (Assign up to six persons to this task depending
on the media weight.)
* When loading roll media, be careful to avoid dropping it on your feet. Also be careful to avoid
catching your fingers. Disregarding this precaution may result in injury due to the weight of
media.

NOTICE

* When using a lifter to load media, prepare a suitable one by checking the specifications.

media. Do not use media that has been wiped free of dust. Wiping media can generate static
electricity, possibly affecting print quality.

» Do not use media immediately after removing it from the package. The media may expand or
contract depending on the temperature and humidity of the location in which it was stored. Allow
the media to stand for at least 24 hours in the same indoor environment as the machine before
loading it.

» Do not use media if it is curled. Curled media may not only damage the print head, but may also
affect print quality.

® » Do not leave the media in the machine when not in use. Otherwise dust may accumulate on the

» Avoid storing unopened media in hot or humid places, or in direct sunlight.
+ After opening, be careful not to touch the surface (especially the printing surface).
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Take-up unit

Use the switch on the take-up unit to change the media take-up direction.

D
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Direction selector swﬂch On/off butto

~ -

Name Overview

Direction Up (reverse) Taken up with the printed surface inside
selector switch

Down (forward) Taken up with the printed surface outside

On/off button Activates/deactivates take-up.
« With a torque limiter attached: Pressing the button activates the take-up unit, which
continues the take-up operation until you press the button again. !

» With a direct-connection unit attached: Activates take-up only while the button is
pressed.

*1. If you want to configure settings so that the feeding operation is performed only while you are pressing the
on/off button, use the feeding/take-up switch settings in the options for roll unit selection. With setup menu
margins set to the minimum (5 mm) on either side. & "Function Setting Menu"(P. 116)

Replacing the direct-connection unit/torque limiter

The take-up/feeding unit should be replaced with a direct-connection unit when tension bars are used, or
with a torque limiter when tension bars are not used.

The torque limiter can change the strength of take-up/feeding operations. (As shipped, the torque limiter is
set to medium.)

Reduce the level of this setting if there is too much tension for lightweight media.

0 » For paper media (transfer paper), use the torque limiter.

® Torque limiter attachment
For media take-up without using tension bars, the direct-connection unit must be replaced with the torque
limiter.

1 Remove the direct-connection unit.

* Remove the knob screw, then remove the direct-connection unit.

A

Direct-connection unit

§‘ob Trews

0
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2 Attach the torque limiter.

(1) Insert the torque limiter.

A

Torque limiter

\

(2) Attach the torque limiter so that the surface is flush with the end of the feeding/take-up unit
shaft, as shown.

+ Efficient media take-up is not possible unless the end of the shaft and the torque limiter
surface are flush.

A —

Torque limiter

tach so that the end.of the shaft and sur
[N}

(3) Tighten the knob screw to secure the torque limiter.

A

o~

® Direct-connection unit attachment

Also refer to the instructions for torque limiter replacement when replacing the torque limiter with the direct-
connection unit.

L+ Attach the direct-connection unit so that the lug on it is aligned with the groove of the feeding/
’g take-up unit.

Groove Projection
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Adjusting the torque limiter

Turn the torque limiter adjustment nut to adjust take-up tension. When adjusting the torque limiters, be sure
to adjust to the same torque for both the left and right take-up units.

Min Mid (recommended) Max

Adjustment nut

d“
L—

Torque scale

\Q/ + For normal printing: Adjust the torque to "Mid".

- » Depending on the media, increasing the torque may cause image defects due to the pinch roller
and grit rollers failing to grip the media. Reduce the torque if the media slips.

® Increase tension (clockwise)

Increase tension when using with heavy or thick media, such as tarpaulin. Perform adjustments manually.

* Do not use the torque adjustment handle. Using the torque adjustment handle will cause
overtightening. Overtightening may damage the take-up unit.

® Decrease tension (counterclockwise).

Decrease tension when using lightweight media. Use the "torque adjustment handle" provided.
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Adjusting tension bar weight

Various types of media are available which feature a variety of thread thicknesses and are woven in different
ways. Even with the same media, elasticity varies depending on pretreatment and other factors. To ensure
correct tension when printing on such diverse media, the take-up/feeding tension bar must be weighted
correctly using tension bar weights and weight-adjustment springs, and reversing bars must be mounted in
the correct positions.

® Counterweights and weight-adjustment springs

You can adjust the weight of tension bars based on where you attach counterweights and how you attach
weight-adjustment springs.

« Perform feed correction as described in &&” "Feed Correction"(P. 97) before attaching
counterweights or springs.

Media/printing conditions Action

» The print surface is tautly tensioned. The media is correctly tensioned. No weight

* Printing is consistent. adjustment is required for the tension bar.

* Minimal sagging or wrinkling is seen in the

media.

» Wrinkling occurs in the media feed direction. The media is excessively tensioned. Reduce the

« The media meanders during printing. counterweights to reduce the weight on the tension
bar to suit the media being used.

* The media sags and is not taken up smoothly. The media is insufficiently tensioned. Increase the
counterweights to increase the weight on the tension
bar to suit the media being used.

Counterweights

* The machine is not shipped with counterweights attached.

» A maximum of 700 g can be attached at each position. Check the media tension and attach a
suitable amount of weight.

+ Counterweights can be attached at four places: two on the feeding side and two on the take-up
side (left and right, in both positions). Attach the same amount of weight at each of the four
positions. Uneven weighting may bend tension bars and affect print quality.

» Keep unused counterweights in the box to avoid losing them.

Weight-adjustment springs

« The machine is shipped with the green spring attached. Tension bar weight can be adjusted by
removing springs or switching to a different type.

» Weight can also be adjusted by attaching weight-adjustment springs at two positions on the
feeding side, at left and right. Set the springs in both positions to the same level. Uneven levels
may bend the tension bars and affect print quality.

» Wear gloves when replacing or removing the springs. The shafts to which the springs are
attached are greased. Do not wipe off the grease on a shaft.

® Tension bar adjustment
1 To adjust tension bar weight, change the weight-adjustment springs.

2 Add or remove counterweights to make tension bars heavier or lighter.

* When adjusting the weight, change it gradually.
» Keep unused weight-adjustment springs in the box to avoid losing them.
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\g/ » For reference, this chart shows the combined effect of counterweights and weight-adjustment
- springs.

Weight with counterweights attached (each side)
Jring Top-mounted
g Bottom-mounted }:%
Jring Top-mounted E[D

g Bottom-mounted | |

Jring Top-mounted | |
g Bottom-mounted [ ] [ 3009 [ 200g [ 200g |

0 5 10 15 20 25 30 35 40 45
Tension bar weight [N]
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Attaching weight-adjustment springs

1 Loosen the screw and remove the bracket holding the weight-adjustment shaft.

% Weight-
~—J  adjustment
* shaft bracket

©

2 Pull out the weight-adjustment shaft.

* Rotate the hole on the weight-adjustment shaft sideways, then raise the tension bar.

eight-adjustment shaft

3 Remove the weight-adjustment spring currently attached.

» Otherwise, replace the current spring with a different one.

<

w—wmght-adjustmem S|

4 Attach the weight-adjustment shaft.

* When attaching the weight-adjustment shaft, make sure the guide is facing the correct way.

%Guide direction

AP
ey
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With the hole of the weight-adjustment shaft facing the side, insert the shaft and push the
bracket all the way in.

6 Tighten the screw.

Attaching counterweights for tension bar weight adjustment

\Q/ « If the counterweights shown below are included (28 weights, 50 g each), they can be attached

- as follows.
» Check the media tension and attach a suitable amount of weight.

» Consider media characteristics when deciding whether to attach counterweights.
» Up to 14 counterweights can be attached on each side, at left and right.
» Loosen the mounting screws to remove counterweights.

Do not remove the weights originally attached.

Mounting screw

\ (\ \
Counterweights J

~~v * When you will attach or remove the last counterweight in the stack, be sure to sufficiently loosen
g the mounting screws. If the screws are not sufficiently loose, the counterweight may catch on
the screws of the weights originally attached, preventing removal.
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Removing the roll media after printing

® Procedure

1 Cut the media.

» Use scissors or the like to cut away the printed portion.

Q » With paper media, be careful to avoid paper cuts from the cut edge.

2 Use the switch on the take-up unit to take up the printed media.

« For instructions on the take-up unit, refer to (& "Take-up unit"(P. 62).

L+ When continuing to use remaining cloth media, cut away any loose threads on the cut

- edge, so that the edge is neat. Loose threads may become caught in the pinch rollers and
prevent correct media feeding.

Using media edge guides

Adjust the media edge guide positions to suit the roll media diameter.

Media diameter Distance between media edge guide and media edge
Not more than 2120 mm 1 mm
2121 mm to 2160 mm 3 mm
2161 mm to 2200 mm 5mm
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Feeding unit

The switches on the feeding unit can be used to change the media feed direction.
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Name

Overview

Direction
selector switch

Up (reverse) .

With a torque limiter attached: To apply tension to media printed
on the outer surface, without using a tension bar.

» With a direct-connection unit attached: To feed media printed on
the inner surface, using the tension bar.

Down (forward) .

With a torque limiter attached: To apply tension to media printed
on the inner surface, without using a tension bar.

» With a direct-connection unit attached: To feed media printed on
the outer surface, using the tension bar.

On/off button | Activates/deactivates feeding.

pressed.

» With a torque limiter attached: Pressing the button activates the feeding unit, which
continues the feeding operation until you press the button again. 1
» With a direct-connection unit attached: Activates feeding only while the button is

.

If you want to configure settings so that the feeding operation is performed only while you are pressing the

on/off button, use the feeding/take-up switch settings in the options for roll unit selection. <& "Function

Setting Menu"(P. 116)

Roll holder setting position

A label showing the roll holder setting position is placed on the leg stay. Use it as a reference to move the

roll holder, then secure using the knob screw.

Set the roll holder reference line within the area
indicated by the arrows as shown below.

Roll Holder 3 Inch Roll Medial} k

Set Position

2 Inch Roll Medial]

B

Settinﬁ;‘ posHition for 3-inch paper core

|

|
|
]
I_
]
1
corrome | e Rt ed ] ]
=========== [ ool veda a |

° 4{—
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Loading Rolls of Cloth Media

Rolls of cloth media can be loaded on the printer with or without using tension bars. The media is detected

as you load it.

* Remove the platens and set the machine for cloth media.
* When loading the media in the center, use the take-up extension cable.

» Adjust the head height to suit the intended use.
« When replacing cloth media after printing, refer to (& "Replacing Cloth Media After

Printing"(P. 92).

Using the tension bars

Follow these instructions to load media using tension bars for take-up and feeding.
The media path when loading cloth media with tension bars is shown in the following figure. Understanding

the media path before loading will make loading easier.

» Before loading cloth media, make sure the area around the grit roller is clean. Clean this area if
it is dirty.

» Before using the tension bar to load media, check that the direct-connection unit is attached to
the feeding/take-up unit. If a torque limiter is attached, replace it with a direct-connection unit as

described in & "Replacing the direct-connection unit/torque limiter"(P. 62).

: =P Media path

0 » Make sure the setting for selecting use of tension bars is set correctly.
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2 Attach reversing bars to suit the media you will load.

» To stabilize feeding-side tension, attach reversing bars at suitable positions for the media you will
load.

» Recommended positions are shown below. If the media is loose or vertically wrinkled with the
reversing bars in these positions, refer to & "Loading roll media without using tension
bars"(P. 80) to set the tension appropriate for the media.

¥

® © ¢

9 9@
@@

-

(1) Loosen the knob screw on the outer surface of the reversing bar brackets on the left and right.

)

* You can now move the reversing bar bracket freely.
(2) While holding the knob screw, move the reversing bar bracket toward you.
* Move the bracket until it reaches the stopper.

Knob screws
Al

(3) Insert and lower reversing bars.
* Fit the reversing bars into the bottom notch of the hole.

» Make sure the reversing bars are mounted in the correct positions. Mounting bars in the
wrong position will prevent you from securing them.

(4) Move the reversing bar bracket toward the machine and secure it.
* Do this for the reversing bar brackets on the left and right.

3 Push the core of the roll media onto the left roll holder.

» Push the roll media fully onto the roll holder until it is held securely.

7
75

7

7
G

1P
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4 Loosen the screw on the right of the feeding unit and insert this side into the paper core.

5 Adjust the feeding legs to stabilize them on the floor.

» Be sure to stabilize the feeding legs on the floor to prevent feeding unit shafts from warping under
the weight of loaded media.

7 Raise the clamp lever on the rear of the machine.

» Leaving the clamp lever lowered will keep the feeding unit locked and prevent you from pulling out
media in step 11 and later.
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8 Insert the roll media into the machine.

(1) Pull out enough media to reach the edge of the platen.
(2) Pass the media over the feeding tension bar and reversing bars to ensure suitable tension.
(3) Insert the media between the platen and the pinch rollers.

» Feed enough media from the roll to be able to hold it from the front of the machine.

(4) Lower the clamp lever on the rear of the machine.

* The media is now held in place.

9 Close the front cover and make sure the clamp lever is lowered.

» A screen is displayed for selecting use of tension bars.

1 0 Select how tension bars will be used, which is based on how the media is loaded.

* In this case, select the option for both feeding and take-up.
(DL: direct-connection unit, TL: torque limiter, --: unit off)

+ Press @ @) to select feeding and take-up, then press the [ENTER] key.

SELECT USE TENSION-BAR

©FEEDING&TAKE-UP DC/DC
OFEEDING ONLY DC
OTAKE-UP ONLY DC
OOFF

m
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1 1 Open the front cover and pull out the edge of the roll.

(1) Open the front cover.
(2) Raise the clamp lever on the front of the machine.

» Before raising the clamp lever, hold the media in place to prevent it from slipping back
toward the feeding side.

(3) Gently pull out the edge of the roll.

+ Pull out the media diagonally upward. Pulling the media out horizontally may catch it on the
grit rollers and scratch the media.

 Pull the media out far enough to cover the tension roller.

1 2 Smooth out any wrinkles in the media, then lower the clamp lever.

 Lightly pull the media in a few areas to remove wrinkles, and make sure the edges are generally
straight before lowering the clamp lever.

1 3 Close the front cover.

1 4 Load the empty paper core in the take-up unit and adjust the take-up legs to stabilize them on
the floor.

 After mounting the paper core, set up the take-up legs on the floor.

Take-up unit
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1 5 Make sure the media is loaded correctly on the feeding side, then press the Enter key.

» The feeding tension bar is activated to detect and adjust media tension on the feeding side.
« |If the media is not detected, raise the clamp lever and repeat this process from step 9.

» Load media so it is not loose.
If the media is loose, a feeding tension bar error may occur.

» Confirm that the rotation direction switch is set to the correct direction.
Media printed on the inner surface: Up (reverse)
Media printed on the outer surface: Down (forward)

1 6 Secure the media on the take-up unit.

(1) Press (@) to feed enough media to reach the floor.

(2) Route the media past the take-up tension bar and then from behind the reversing bar.
(3) Secure the middle of the media with adhesive tape.
(4) Secure the left and right sides the same way.

» Pull the left and right sides of the media evenly, making sure the media is not too loose or
wrinkled, then secure it with tape.

(5) Lower the clamp lever on the rear of the machine.
* The media is now held in place.

» Secure wide media in at least five positions with tape or the like. The more positions
secured, the more even the media tension will be.

« If the paper core is misaligned with the cloth as loaded, loosen the roll holder screw and
adjust to bring the core into position.

* From a low line of sight with the feeding roll visible, make sure both media edges are
aligned with both edges of the feeding roll.
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Press the take-up unit switch to take up the media a little, about one revolution, onto the paper
core.
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(1) Take up the media by setting the take-up direction selector switch at left and then pressing the
on/off button at right to activate it.
(2) Once the media is taut, stop take-up by pressing the on/off button at right off.
» The take-up unit should revolve at least once as you take up media.

+ If not, press (¥ again to feed the media and take it up with the take-up unit.

« If there is not enough media to wrap around the paper core, be sure to press (¥) to feed
the media before taking it up with the take-up unit.
Forcing take-up without enough media may damage the machine.

1 8 Open the front cover and lightly insert the media under the cloth holders.

» Position the media so that it does not extend to the right of the v-groove on the platen.
« For thick media, perform the procedure in <& "Adjusting the cloth holders"(P. 79).

Cloth holder \

S

» Prevents curled, warped, or frayed edges of the cloth from lifting up.
* Prevents bleed-through ink mist during printing.

» When loading media, align the right edge with the groove on the platen. Placing media
farther right than the groove will make it rise up if it moves obliquely, which may damage
the head.

* A notification reading "Media Set Position R" will appear after media width detection if the
media is too far to the right of the specified position. Reload media in the specified
position.

o Be sure to use cloth holders. Using cloth holders has the following effects:
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1 9 Close the front cover and press [ENTER].
» The take-up tension bar is activated to detect and adjust media tension on the take-up side.
» After media detection on the take-up side, the media take-up diameter is detected. >
+ |If the media is not detected, repeat this process from step 2.

* Load media so it is not loose.
If the media is loose, a take-up tension bar error may occur.
» Confirm that the rotation direction switch is set to the correct direction.

Media printed on the inner surface: Up (reverse)
Media printed on the outer surface: Down (forward)

20 Set the take-up diameter.

« When the take-up diameter detection in the options is set to "AUTO" ((&° P. 116), the media take-
up diameter is automatically detected after the media is loaded.

(1) After the take-up diameter is automatically detected, a screen appears to confirm the detected

CHECK DIAMETER
FEEDING UNIT 250mm
TAKE-UP UNIT 50mm

take-up diameter.m

(2) Check the actual take-up diameter, and if there is no problem, press the [FUNC3] key (OK).

« If there is a difference between the displayed and the actual take-up diameters, press the [FUNC1]
key (No Good) and correct the take-up diameter.

INPUT DIAMETER
FEEDING UNIT 250mm
TAKE-UP UNIT 50mm

(1) Enter the take-up diameter of the feeding unit.
+ Press @ @) to select the feeding unit, then press the [ENTER] key.

+ Press @ @) to enter the media outer diameter (diameter) of the feeding unit, then press
[ENTER] key.

(2) Enter the take-up diameter of the take-up unit.
+ Press @ @) to select the take-up unit, then press the [ENTER] key.

+ Press @ @) to enter the media outer diameter (diameter) of the take-up unit, then press
[ENTER] key.

(3) Press the [FUNC3] key (OK) when you have made the correction.

« When the take-up diameter detection in the options is set to "MANUAL" (&&° P. 116), enter the
take-up diameter using the procedure above.
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Adjusting the cloth holders
Adjust the height of the stainless steel plates to suit the cloth thickness.

1 Remove the cloth holders.
+ Slide the cloth holders to the edge of the platen and remove them.

Knob screws

* The head height should also be adjusted to suit the cloth thickness when thick cloth is
held by the cloth holders. Leaving the head low may damage it.

Adjusting the reversing bars
To print with suitable tension for the media, adjust the positions and quantity of reversing bars.

® Adjustment if media is too loose
Make the wrap angle larger. This will increase media tension.
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® Adjustment if media is too taut

Make the wrap angle smaller. This will decrease media tension.

Loading roll media without using tension bars

Follow these instructions to load media without using tension bars. When setting media, read the following
notes carefully.

o * When loading media without using tension bars, replace the direct-connection unit on the

feeding/take-up unit with an included torque limiter. & "Replacing the direct-connection unit/

torque limiter"(P. 62)
» Continuous printing without tension bars is limited to about 10 m. For continuous printing longer

than 10 m, use tension bars to load the media.

The media path when loading cloth media without tension bars is shown in the following figure.
Understanding the media path before loading will make loading easier.

: =P Media path

it is dirty.
* When loading roll media without using tension bars, adjust media tension with reversing bars
and torque limiters.

0 + Before loading cloth media, make sure the area around the grit roller is clean. Clean this area if
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1 Load the media on the feeding side.

+ Follow steps 4-8 in &~ "Using the tension bars"(P. 71).
» The feeding tension bar must be moved temporarily.

1) Hold the tension bar
against the back of the main

unit. /
5%

Feeding tension bar

[ 2) Load the roll media.

3) Return the tension bar to
the original position.

2 Close the front cover and make sure the clamp lever is lowered.

» A screen is displayed for selecting use of tension bars.

3 Select how tension bars will be used, which is based on how the media is loaded.

* In this case, select OFF.
(DL: direct-connection unit, TL: torque limiter, --: unit off)

+ Press @ @) to select OFF, then press the [ENTER] key.

SELECT USE TENSION-BAR

OFEEDING&TAKE-UP  TL/TL

OFEEDING ONLY TL
OTAKE-UP ONLY TL
©OFF

m

» The screen for selecting use of tension bars is not displayed if both the feeding and take-
up tension bar settings are set to OFF in the options for roll unit selection. (The media
selection screen is displayed.)

4 Feed the media to the take-up side and load an empty paper core in the take-up unit.

« Follow steps 10-15 in (& "Using the tension bars"(P. 71).

5 Secure the media on the paper core, and then set the cloth holders.

+ Follow steps 17—19 in (25 "Using the tension bars"(P. 71).
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Loading Roll Media (Transfer Paper)

Loading paper media does not require use of tension bars. When setting media, read the following notes
carefully.

» Replace the direct-connection unit on the feeding/take-up unit with an included torque limiter.
(& "Replacing the direct-connection unit/torque limiter"(P. 62)

» Continuous printing without tension bars is limited to about 10 m. For continuous printing longer
than 10 m, use tension bars to load the media.

The media path when loading paper media (transfer paper) is shown in the following figure. Understanding
the media path before loading will make loading easier.

: =P Media path

\Q/ + Pass the media between the tension roller and the main unit.

~ » Setreversing bars in holes where they will not interfere with the media.

1 Remove take-up reversing bars.

» Remove take-up reversing bars to avoid interfering with the media.
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2 Mount take-up reversing bars in the reversing bar bracket on the feeding side.

* Mount the take-up reversing bars you removed in the reversing bar bracket on the feeding side in
the rear.

* Mount the take-up and feeding reversing bars in the following positions.

Take-up reversing bar

O @[6

5 0|6

O ©
r Feeding reversilng bars

3 Load the media on the feeding side.

» The feeding tension bar must be moved.

1) Hold the tension bar
against the back of the main
unit.

Feeding tension bar

[ 2) Load the roll media.

3) Return the tension bar to
the original position.

4 Pull out the edge of the roll.

(1) Open the front cover.
(2) Raise the clamp lever on the front of the machine.
(3) Gently pull out the edge of the roll.

R
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\Q/ » Pass the media between the tension roller and the main unit.

5 Ensure that the roll media is uniformly loaded, then lower the clamp lever.

+ Lightly pull the media in a few areas and make sure that it has been pulled out uniformly, then
lower the clamp lever.

6 Use the media holders to hold the media in place lightly.

» Position the media so that it does not protrude on the right end beyond the rightmost pinch roller.
* When using thick media, remove the media holders from the media before printing.

é * When loading media, align the right edge with the groove on the platen. Placing media
farther right than the groove will make it rise up if it moves obliquely, which may damage
the head.
* A notification reading "Media Set Position R" will appear after media width detection if the

media is too far to the right of the specified position. Reload media in the specified
position.

7 Close the front cover and make sure the clamp lever is lowered.

» A screen is displayed for selecting use of tension bars.
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8 Select how tension bars will be used, which is based on how the media is loaded.

* In this case, select OFF.
(DL: direct-connection unit, TL: torque limiter, --: unit off)

+ Press ) (@) to select OFF, then press the [ENTER] key.

SELECT USE TENSION-BAR

OFEEDING&TAKE-UP  TL/TL

OFEEDING ONLY TL
OTAKE-UP ONLY TL
©OFF

m

» The screen for selecting use of tension bars is not displayed if both the feeding and take-
up tension bar settings are set to OFF in the options for roll unit selection. (The media
selection screen is displayed.)

9 Set the take-up diameter.
* Follow step 20 in & "Using the tension bars"(P. 71).

1 0 Load an empty paper core on the take-up unit.

+ After mounting the paper core, set up the take-up legs on the floor.

Take-up unit

1 1 Secure the media on the take-up unit.

(1) Press the [FUNC3] key.

(2) Press () to feed enough media to reach the paper core in the take-up unit.
(3) Secure the middle of the media with adhesive tape.

(4) Secure the left and right sides the same way.

+ Pull the left and right sides of the media evenly, making sure the media is not too loose or
wrinkled, then secure it with tape.
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Loading Leaf Media (Cloth Media)

Unlike roll media, leaf media does not need to be retained with the roll holders.

* Remove the platens for paper media and install the ink-receiving pan spacers, checking that the
machine is set for cloth media.

1 Set both the feeding and the take-up units to OFF in the options for roll unit selection.

2 Open the front cover and raise the clamp lever.

Front cover

3 Insert leaf media between the pinch rollers and platen, then lower the clamp lever.

» Set the media so that no media sticks out from the right end pinch roller to the right side.

4 Use the cloth holders to hold the media in place lightly.

» Position the media so that it does not extend to the right of the v-groove on the platen.
* When using thick media, remove the cloth holders from the media before printing.
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5 Close the front cover.

» Set the media straight.

* Only use leaf media that has some stiffness.
Because the take-up unit is not used with leaf media, the printing surface of flimsy media
may not be flat, which may cause it to jam.

* Load media that is long enough to cover the tension roller. Media shorter than this may
become caught between the tension roller and cloth-wound roller and get jammed.
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Loading Leaf Media (Transfer Paper)

Unlike roll media, leaf media does not need to be retained with the roll holders.

» Check that the platens for paper media are installed and that the machine is set for paper
Z ” 5 media.

1 Set both the feeding and the take-up units to OFF in the options for roll unit selection.

2 Open the front cover and raise the clamp lever.

3 Insert leaf media between the pinch rollers and platen, then lower the clamp lever.

» Set the media so that no media sticks out from the right end pinch roller to the right side.

4 Use the media holders to hold the media in place lightly.

» Position the media so that it does not extend to the right of the v-groove on the platen.
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é » When loading media, align the right edge with the groove on the platen. Placing media
farther right than the groove will make it rise up if it moves obliquely, which may damage
the head.
» A notification reading "Media Set Position R" will appear after media width detection if the
media is too far to the right of the specified position. Reload media in the specified

position.
G & S
I|| ‘@X«\(

NZaW

NG Qf\' 2
Groove Q) . =
@ ! Media polder ¢

N A
ST

P <RI
A\ ,/;ﬁ' o N \
Media \\

5 Close the front cover.

» Set the media straight.

é * When loading media, have at least 150 mm over the platen and pass it between the
tension roller and main unit. If media is not routed correctly, it may lift up and damage the
head.

* Only use leaf media that has some stiffness.
Because the take-up unit is not used with leaf media, the printing surface of flimsy media
may not be flat, which may cause it to jam.
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Registering the Media

When the clamp lever is lowered with media being loaded, the Select Use Media screen is displayed.
Registration is required to use media that is not registered on the machine.

1 Select [Unregistered].

Media selection
e PVC 1300 mm

o Tarpaulin 1600 mm
o Unregistered
o Unregistered
o Unregistered

2 Select the media type.

Media Type

e Decalcomania paper (thin)
o Decalcomania paper (mid)
o Decalcomania paper (thick)
o Cloth/fabric

o Synthetic paper

3 Select the media width detection type.

* AUTO: The media width is automatically detected with the sensor.
+ MANUAL: The media width is manually set.

Media Detection Type
Please Select.

AUTO
MANUAL

\Q/ » Media width may not be detected correctly for certain colors or types of media. When

- media width cannot be detected correctly, set the media width detection method to
"MANUAL".

4 Select the method for managing the media remaining amount.

» Select whether or not to manage the media remaining amount with the machine.

Media Registration
Media Remain Manage
Please Select.

ON
OFF

5 Enter the name to be displayed.
« If you do not register the name, press the [ENTER] key.

Media Name Change
Media 3

will be changed
(maximum 10 characters)
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6 Select whether or not to register the set information.

do you optimize setting?

Execute
Do not

\Q/ « You can change the settings later. (& "Media Setting Menu"(P. 108)
® Media optimization settings
Optimizing the settings sets the various items as follows, depending on media type:

Settings Default Transfer paper Cloth
MAPS Auto Auto Auto
Vacuum fan strength Strong Strong Strong*1
Vacuum fan constant operation On On on’
Feed speed (%) Host 100 100
Pre Feed Host Off Off

*1. When the removable platens are not fitted (cloth media), the vacuum fan will remain off regardless of the
setting.
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Reset the Media
If you change the setting of the print area without raising the clamp lever or re-perform the media detection,

please perform the following operation.

1 Press the [SEL] key in the local mode,and then press [FUNC2 (MEDIA)].

2 Press the @) or(Ykey to select the method of resetting the media, and then press [ENTER] .

» Media resetting can be selected from two methods.
(1) Width only: Sets only PRINT AREA [WIDTH].
(2) All: Resets all media sensor information.

3 Press the [ENTER] key.

Replacing Cloth Media After Printing

When cutting the cloth media after printing, the cloth media comes into contact with the ink-receiving pan

spacers and gets dirty.
This section describes how to help prevent cloth media from getting dirty during cutting.

1 Remove the cloth holders from the media. (Left/right)

y

2 While lifting the cloth media, cut the back side (between the ink-receiving pan spacer and the

R platen).
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Cut all of the cloth media as you place it on the peeling roller.

+ Lift up the cloth media as you cut it so that the cut cloth media does not touch the ink-receiving
pan spacer.

Clean the ink-receiving pan spacers. & "Ink-Receiving Pan Spacer Cleaning"(P. 130)

Load new media.
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2.8 Test Printing

Print a test pattern to confirm that the ink prints correctly. Perform head cleaning if you observe any ejection
failures (e.g., nozzle clogging or deflection). (25 "Head Cleaning"(P. 96)

[For Sb411 ink]

[For Sb420 ink]

Check beforehand

+ Was the print head adjusted? (&> "Adjusting Print Head Height"(P. 56)
* Is media loaded? (22" "Loading the Media"(P. 61)

* Load media at least 500 mm wide. You cannot print the entire pattern if media less than 500
mm wide is used.

\Q/ + Select [Maintenance] > [Nozzle Recovery] > [Test Print], then select "ON" to perform nozzle

- recovery and test printing.
Registration is required to perform nozzle recovery. & "Registering Nozzle Recovery"(P. 114)
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Changing the Layout Direction for Test Printing

You can change the layout direction for test printing.

. [ Scan direction

(Prints repeatedly in the horizontal direction.)
[ 2 1 [ Feed direction
[ [ 3 [ 2 1[ 1 ] (Feeds the medium and prints repeatedly in the longitudinal direction.)

1 On the LOCAL mode screen, select [TEST PRINT/CLEANING] > [Test Print], then press the
[ENTER] key.

* The Test Print menu is displayed.

2 Select [Scan Dir.] or [Feed Dir.], then press the [ENTER] key.
» Test printing starts.

Good example Bad example

7.
|

—_—\ )

o, =

Nozzle Deflection Nozzle clogging

3 Check the print results.

Ejection Failures

Typical examples of ejection failures (e.g., nozzle clogging, deflection) are as shown below. In order to
prevent printing in such a state, check whether the ink has been properly ejected regularly before printing.

Nozzle clogging

51
50 50 ]
" ]
—3 —30 ]

Mist Mixed air

[ENENENENENNERERN]
[EEEEENINENNNNNEN|
INENNNENNNNNNNEN|
IHENENENNENNENEN

EEENERNNE]
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2.9 Head Cleaning

The following head cleaning methods are available. Choose the method based on test results. Cleaning is
not possible when the [Ink Near End] or [Ink End] errors are displayed. Replace with new ink. & "Replacing

Ink"(P. 42)
Item Details
Soft If the print shows a bent line (Nozzle deflection)
Normal If the print shows a missing line (nozzle clogging)
Hard If soft cleaning and normal cleaning fail to resolve ejection failures (e.g., nozzle clogging
or deflection).

1 On the LOCAL mode screen, select [TEST PRINT/CLEANING] > [Cleaning], then press the
[ENTER] key.

» The Cleaning menu is displayed.

2 Select the cleaning type, then press the [ENTER] key.

3 Select the head to be cleaned, then press the [ENTER] key.

* Check the check box. Heads with checked check boxes will be cleaned.

4 Run another test print and check the print results.

* Repeat the cleaning and test printing process until the print results appear normal.

\ /

~~ * Do the following if head cleaning fails to resolve the ejection failures (e.g., nozzle clogging
’g‘ or deflection).

& "Cap Rubber Cleaning"(P. 124)
& "Print Head Nozzle Washing"(P. 166)
& "Wiper Cleaning"(P. 126)
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2.10 Feed Correction

Changing the media may affect the feed amount due to various factors, including the weight and thickness of
the media and whether the take-up unit is used. Correct the drop position to suit the type of media used.
Image defects (e.g., dark or light streaks) will result if the feed is not properly corrected.

Check beforehand

* Is media loaded? (2" "Loading the Media"(P. 61)
» For roll media, is the rear roll media free of sagging?

« When using the take-up unit, is the media mounted on the paper core of the take-up unit? & "Loading
Rolls of Cloth Media"(P. 71)X& "Loading Roll Media (Transfer Paper)"(P. 82)

Feed Correction Procedure

Print a correction pattern, then enter the correction value. The value corrected here will also be updated on
the Media Setting menu.

« Set the media aligning the center datum with the media setting position guide plate. " "Roll
holder setting position"(P. 70)
Check and adjust around the center of the machine.

0 * When using the take-up unit, load media on the take-up unit before correcting.

1 On the LOCAL mode screen, select [ADJUST].

LOCAL

width:1340mm

OO 0000
Cowsr |~ pncean

2 Select [Feed Comp.], then press the [ENTER] key.

 Correction pattern printing starts.

3 Check the print results.

» A correction value input screen appears.
» Adjust the bands so that the region between them is evenly colored.

Seconld band Good example Bad example

First band

4 Enter the correction value, then press the [ENTER] key.

* "+" input: Increases the separation between bands.
« "-"input: Reduces the separation between bands.
* Increment the correction value by "30" to move the bands by approximately 0.1 mm.

5 Press the [ENTER] key.

* Print another correction pattern to check.
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Correcting the Media Feed During Printing

You can also correct the media feed amount in REMOTE mode or during printing.

1 Press [ADJUST] in REMOTE mode or during printing.

2 Enter the correction value, then press the [ENTER] key.

» Correction value: -9999 to 9999
» The value entered here will be updated immediately.
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2.11 Correcting the Drop Position

Changing the media and print head height and temperature changes around the print head will also alter the
drop positions. Correct the drop position to suit the type of media used. Image defects (e.g., overlaid lines or
blurred images) will result if the drop position is not properly corrected.

Check beforehand

+ Was the print head adjusted? (25> "Adjusting Print Head Height"(P. 56)
* Is media loaded? (2&° "Loading the Media"(P. 61)

» Load media at least 500 mm wide. You cannot print the entire pattern if media less than 500
mm wide is used.

Drop Position Correction Procedure

Print a correction pattern, then enter the correction value. The value corrected here will also be updated on
the Media Setting menu. This must be adjusted for each print resolution.

holder setting position"(P. 70)

0 « Set the media aligning the center datum with the media setting position guide plate. &~ "Roll
Check and adjust around the center of the machine.

1 On the LOCAL mode screen, select [ADJUST].

LOCAL

width:1340mm

QO 0000
ot | rio

2 Select [Drop.PosCorrect], then press the [ENTER] key.

3 Select the resolution, then press the [ENTER] key.

» Select the resolution to be adjusted. When "All" is selected, correction patterns for all resolutions
will be printed. &~ "Media Setting Menu"(P. 108)

\Q/ * The indicated resolutions are those in the scan direction.

4 Check the print results.

» A correction value input screen appears.
» Enter the position where the two upper and lower lines coincide.

0
+ €= > —

lMediafeeddirection
A

IT\In this case, the drop position correction value will be "+4
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5 Enter the correction value, then press the [ENTER] key.

e Correction value: -40 to 40

\Q/ « If the lines do not coincide when the correction value is within the range -40 to 40, the

- print head height may have been improperly adjusted. Adjust the print head height.
& "Adjusting Print Head Height"(P. 56)

6 Enter the correction value in the same way for pattern 2 and subsequent patterns.
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2.12 Preparing RIP data

The explanation here applies to MIMAKI RIP software (RasterLink).

» Prepare suitable image data for printing.

1 Launch RasterLink.
* Click the icon on the PC desktop.

lostor
Link

oAy

2 Select the image data to print.

(1) Select [File] > [Open].
(2) Select the desired image data, then click [Open].
 If multiple printers are registered, select Tx330-1800 in "Printer Name".

Select file name to print x
€ >~ 4 705 ThisPC » Local Disk(C) > test v C 2 Search test
Organize = New folder =- m @
Name Date modified Type Size
>+ Quick access
=1 12/2/2019 8:14 AM Encapsulated PostScript 2,119Ke
> | Creative Cloud Files
=2 12/2/2019 9:15 AM Encapsulated PostScript 2,153KB
> @ OneDrive =3 12/2/2019.9:15 AM Encapsulated PostScript 2,151 K8
R 1272019 0:
v B ThspC =4 12/2/2019 9:16 AM Encapsulated PostScript 2,146 KB
~ 72/, A
3 @ Deskiop s 12/2/2019 9:16 AM Encapsulated PostScript 2,142KB
> [ Documents
> Downloads
> @ Music
> Pictures
> [ Videos
> e Local Disk (G
> 3 Network
Fizmrms v| Al Files -
=] =

3 Select the image data imported.
* The image data is added in the tab for Tx330-1800 selected in "Printer Name".

% MimakiRasterLink7 0.2.0 Alpha Release 0

File Function Tool Environments About

Frinter Job List 1foperties

own [ 50 o
[EOETT B Job Neme TBLUETLocy 01 jpe.
sperow ] ] 0H
[EETE BT File eme [BLUEILady D1ive
[ltantveents [[ [ oW R FEG
Gliehtopn [ | E
S = Inaes Sie 01017 kB
Gtsalrsia Poge size 160620 % 107105
Favaites t the o
Media Size
Job ttribute Full Golor ][ sew |
SeanO Auto Detecti

Use special color names|Not Exist

© Mot et =
Vamnele | 30005 m |

Inage Edit

Color Adjustment Set [ Nor mal

|ty
Job Queue [ 1] Runming Media M 40C-114 v35
Thumbr. Job Na.. Status _ Progress. Resolution 001200 VD
Tnput Profile (10G) WimskiHiContrasticm
Profile Name

Overprint times
Pass

Pass quality sstting

EHEREEEER
& g
g
g
3
%
g

Print Direction i-direction
Spocal ok Ove Prin

sults

Ink. Gonsumption

o
el
@ @ @ Black. [o0ee ]

ol (87 wifs042mk2_8c_lus120cmyk clpwm [21 jv300plus_Sc_ss2icmyklelmwn [0 ucjvand [ 21 |
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4 Edit the image.

» Specify the following settings by clicking the function icons shown on the right-hand side of the
screen:

N} (General Print): Specifies settings like enlargement/reduction and rotation.

Q (Quality): Selects a color profile for the media and ink set loaded in this machine.

» For more information, refer to the RasterLink reference guide. https://mimaki.com/
download/software.html

5 Print image data.
« (& "Starting Printing"(P. 104)

(1) Click =% (Execution) from the function icons on the right-hand side of the screen.
(2) Select "Immediate Print" or "RIP and Print", then click [Start].

~~v °* Media width must be reacquired after replacing media.
g (1) Select the tab for Tx330-1800 in the main window.

(2) Click k\_ (Update the printer status) in the Printer tab.
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2.13 Printing

Check beforehand

« Was the print head adjusted? (& "Adjusting Print Head Height"(P. 56)
* Is media loaded? &8 "Loading the Media"(P. 61)
 For roll media, is the rear roll media free of sagging?

« When using the take-up unit, was the media mounted on the paper core of the take-up unit? <&~
"Loading Rolls of Cloth Media"(P. 71)&& "Loading Roll Media (Transfer Paper)"(P. 82)

~ + Condensation may form on the print head nozzle surface depending on the ambient

’g‘ temperature and humidity. The formation of condensation may cause ejection failures (e.g.,
nozzle clogging or deflection). Perform head cleaning if any ejection failures (e.g., nozzle
clogging or deflection) occur during printing. (2~ "Head Cleaning"(P. 96)

Changing the origin

The print start position can be altered. Use the LED pointer to set the origin.

 Print origin default value
— Feed (longitudinal, X") direction: Approx. 80 mm to rear from platen front edge
— Scan (lateral, Y') direction: 15 mm from right edge of media

M mm (Y'")

Platen front
edge
I Approx. 80 mm (X')

1 On the LOCAL mode screen, press @ ® @ ).

» The Origin Setup screen appears.

2 Press () (¥ @ ® to move the origin to the desired position.

» The carriage moves left and right and feeds the medium.

+ The media cannot be fed backward when using cloth media (with the platens not fitted).

3 Press the [ENTER] key.
» The origin is updated.
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Starting Printing

1 Send the RIP data from the PC.
« & "Preparing RIP data"(P. 101)

L - Ifthe message "Attention20A Driver version" appears, install the latest Mimaki driver.
’g\ https://mimaki.com/download/inkjet.html

2 Start printing.
» Printing starts once RIP data is received.

[Number of passes] [Scan speed] (Std: standard, Hi: high speed)
[Resolution] \ / [Dot type]

: VD: Variable dot

[Nozzle Recovery] 600x600 /// \Vd ND: Normal dot
: NR .0m
NRS: All nozzles can be recovered \Length of medium printed
NI:E: A part of nozzles can be recovered \_//:x
OFF : Not registered or the print mode o L o
[Scan direction] (Uni: unidirectional, Bi: bidirectional)

where nozzles cannot be recovered

M  Print speeds may differ for the same image data, depending on the width of the medium

’g‘ loaded, print origin position, and resolution.
« If an error occurs, the machine switches to LOCAL mode once printing is completed.

Further printing is not possible.

Pausing Printing

1 Press [LOCAL] while printing is in progress.
* Printing is paused.
« If data is being sent from a PC, data transmission is paused at the PC.

9 Press [REMOTE].

* Printing resumes.

\Q/ + No other functions can be used when printing is paused.
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Stopping Printing (Data Clear)

1 On the LOCAL mode screen, select [DATA CLEAR].

LOCAL

width:1340mm

OO 0000
Cower | wion

2 Press the [ENTER] key to clear the received data.

* The receive buffer is cleared.
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Chapter 3 Setup

3.1 Media Setting Menu

When you use the machine for the first time, the Select Use Media screen is displayed. (2” "Registering the
Media"(P. 90) The media Information and correction value can be saved in advance for specific media.

The user can select to prioritize the settings on the machine or the settings on the PC. Setting individual
menus to "Host" prioritizes PC settings. To prioritize settings for this machine, select a setting other than

"Host".
<4« For more information on how to specify RIP software, refer to the RIP software operating
’g‘ manual.
® Menu List
Item Setting Details
*1 *2
Feed Comp. -9999 to 0 to - | Corrects the media feed amount. Print a pattern and enter the
9999 correction amount. (& "Feed Correction"(P. 97)
Drop.PosCorrect - - | Corrects the drop position for bi-directional printing. (2
"Correcting the Drop Position"(P. 99)
(Resolution) * - | Select the resolution to be corrected.
When "All" is selected, correction patterns will be printed for all
resolutions.
* The available resolutions vary according to the model.
(Correction -40.0to 0 to - | Check the pattern and enter correction values.
Value) 40.0
Auto-correction - - | The auto-correction function (DAS: Dot Adjustment System)
Al i detects a correction pattern with the sensor and automatically
corrects the drop position.
Feed Comp. - - | When "All" is selected, "Feed Comp." and "Drop.PosCorrect”
are corrected.
Drop.PosCorrect - - ) ) )
» Check to confirm that the media does not lift up.
» Load white and clean media.
» Media such as synthetic paper, tarpaulin, or cloth media
may not be detected.
* Do not send RIP data from the PC during pattern printing.
« If automatic correction is unsuccessful, correct the position
manually. [MENU] > [Media Setting] > [Feed Comp.] or
[Drop.PosCorrect]
(Resolution) * - | Select the resolution to be corrected.
When "All" is selected, correction patterns will be printed for all
resolutions, and the drop position is corrected automatically.
* The available resolutions vary according to the model.
External Heater ON/OFF Turns the external heater on or off.

MAPS4

MAPS: Mimaki Advanced Pass System

This function disperses the boundaries between passes to
make feed streaks between passes less visible.

Altering MAPS may alter the color. This function may be less
effective with certain types of images.

* The MAPS version will vary according to the model.
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Item Setting Details
*1 *2
MAPS” AUTO/ - | This should normally be set to "AUTO". When set to
MANUAL "MANUAL", the following items are displayed:
Speed 50 to 100 % - | Reducing speed will make streaks less visible. However,
printing will be slower.
Smoothing 0to 100 % - |Increasing smoothing makes streaks less visible. Make
Level (Color) separate settings for color and spot color (white).
Media Information - - | Enter the media information.

Media Type - - | Select the media type to be used. The available media types
vary depending on the model.

Media Width - - | Sets the media width detection method.

Detection AUTO/ * AUTO: The media width is automatically detected with the
Type MANUAL sensor.
+ MANUAL: @ Press ® to set the media width manually.
— When media width cannot be detected correctly, set the
media width detection method to "MANUAL".

Media Remain - - | The remaining roll media amount can be displayed and printed
out in REMOTE mode. The print length will be displayed when
leaf media is in use.

Media ON/OFFE - * ON: An input screen appears once the media width is

Remain detected. @ Press () to set the media length.

Manage Press the [FUNC3] key on the "Origin Setup" screen to
print the date and remaining media amount.

» OFF: The remaining media amount is not displayed.

Length 0 to 500 m - | Enter the roll media length.

Stop Printing ON/OFF Setting to "ON" stops printing when the Media Remain value

reaches 0.
Detail Setting - - | This is used to set various functions.
Vacuum Fan Strong/Weak/ | Stro | Sets the force with which the medium is held down.
Standard/Host| ng | « This can be used to prevent media jamming and print

head damage caused by the media lifting up.

Continuous ON/OFF * ON: The media is constantly held down under vacuum.

Running + OFF: The media is held down by vacuum only when
required, such as during printing and feeding.

Feed Speed Host/10 to 100 | Sets the media feed speed.

100 to 200 % + Depending on print conditions, the speed may not vary for
certain settings.

» Setting to 100 % or more reduces the time required to
complete printing but may affect print quality due to
insufficient drying time.

Pre Feed - - | Sets the conditions for media feeding before printing.

Drying Feed OFF/100 to |OFF [ Sets the distance for media feeding after printing.

1000 mm
Media Name - - | You can change the name of a setting type. The name can
Change include alphanumeric characters or symbols.
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Item Setting Details

*q *9

Delete Medialnfo - - | Delete the set media information.

*1. The default settings are shown underlined.
*2. Settings applied if no settings can be made in the RIP software (host) or if this machine is prioritized.
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3.2 Maintenance Menu

This menu is used for maintenance actions. It also lets the user perform nozzle recovery if nozzle clogging
persists even after cleaning and nozzle washing.

® Menu List
Item Setting*1 Details

Station Maint. - This moves the carriage to allow station and print head

Carriage Out i maintenance.

Move To Platen - Cleans around the station, including caps and wipers, and
Right End changes the head height.
(%" "Cap Rubber Cleaning"(P. 124)
& "Wiper Cleaning"(P. 126)
& "Adjusting Print Head Height"(P. 56)
Move To Maint. - Cleans around the print head.
Space (%" "Carriage Underside Cleaning"(P. 125)
& "Media Sensor Cleaning"(P. 132)
& "DAS (Automatic Correction Function) Sensor
Cleaning"(P. 129)

Nozzle Wash 1to 99 min | Washes the print head nozzle surface with maintenance liquid to
resolve ejection failures (e.g., nozzle clogging or deflection). (&~
"Print Head Nozzle Washing"(P. 166)

Pump Tube - Washes the suction pump tube (below the cap). & "Ink Discharge

Cleaning Channel Cleaning"(P. 131)

Custody Wash 1to 99 min |Perform this step if the machine will not be used for extended
periods. The function washes nozzles and drainage channels to
maintain the machine in optimal condition. & "When this Printer is
Left Unused for a Long Time"(P. 139)

Replace Wiper - Use this function when replacing the wiper. Replacing the wiper
resets the wiper usage counter. (" "Wiper Replacement"(P. 143)

Cap Replacement - Use this function when replacing the cap. Replacing the cap resets
the cap usage time stored in the machine. (& "Cap
Replacement"(P. 146)

Test Printing - Print a test pattern to confirm that the ink prints correctly. Perform
head cleaning if you observe any ejection failures (e.g., nozzle
clogging or deflection). & "Test Printing"(P. 94)

Cleaning - Several head cleaning methods are available. Choose the head
cleaning method based on test print results. &~ "Head
Cleaning"(P. 96)

Nozzle Recovery - Allows other nozzles to be used for printing if maintenance actions
like nozzle washing fail to resolve print defects (e.g., nozzle
clogging, deflection).

Print - Prints a pattern to check nozzle condition and register the nozzle.
& "Registering Nozzle Recovery"(P. 114)

Entry - Registers the nozzle without printing a pattern.

Reset - Initializes the details set.

Test Printing ON/OFF Sets whether to perform nozzle recovery before test printing.

Nozzle Check - & "Nozzle Check"(P. 115)
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Item Setting*1 Details
Printing Check ON/OFF Performs nozzle clogging detection before printing starts.
Check Interval - Sets the nozzle clogging detection timing.
Length 0.1 to 30.0 to | Performs nozzle clogging detection after the length set is reached
100.0 m and before the next print starts.
File 1to30to |Performs nozzle clogging detection after the preset number of files
1,000 files | has been printed and before the next print starts.
Continuation Stop/ Select whether to stop or continue printing if "Nozzle clogging" is
Print Continuous |detected.
Action Off/1 to 10 to | Performs nozzle recovery (cleaning followed by nozzle checking) if
100 "nozzle clogging" is detected.
Cleaning Soft/Normal/ | Sets the cleaning type.
Hard
Retry Count 0 to 3 times | Performs nozzle recovery (cleaning followed by nozzle checking)
for the specified number of times.
Auto Nozzle ON/OFF Performs nozzle recovery automatically if "nozzle clogging" is
Recovery detected. See below if you wish to perform nozzle recovery
manually.
& "Registering Nozzle Recovery"(P. 114)
Judgment Condition | OFF / 1 to 64 | Set the number of nozzles to be detected as clogged before
nozzles "nozzle clogging" is detected. Up to 16 nozzles per row can be set.
The next print will not start if "nozzle clogging" is detected during
continuous printing.
Auto Maint. - Sets various maintenance actions to be performed automatically.
Set the interval between individual maintenance actions.
+ If the warning message "Replace Wasteinktank" appears, the
automatic maintenance function is disabled. (" "Waste Ink
Tank Replacement"(P. 158)
Refresh 0.5/1.0 h | Sets the refresh interval (when a small amount of ink is ejected
from the print head nozzles).
Pump Tube OFF/48h/1 to | Sets the interval for washing the suction pump tube (below the
Cleaning 168 h cap).
Cleaning Interval 1to48 h |Sets print head cleaning intervals. This will help prevent nozzle
clogging.
Type Normal/Soft/ | Sets the cleaning type for head cleaning.
Hard
Print Maint. - Sets the maintenance to be performed automatically midway

during printing.

Auto Cleaning

Sets the conditions to perform head cleaning after the preset
number of files are printed.

Setup File/Length/ |Sets the conditions to perform head cleaning.
Time/OFF
Interval - Sets head cleaning intervals.
(File) 1to 1,000 |Cleaning starts when the set number of files is exceeded.
(Length) 1to 1,000.0 |[Cleaning starts when the set print length is exceeded.
m
(Time) 10 to 240 min | Cleaning starts when the set print time is exceeded.
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Item Settin g*1 Details
Type Normal/Soft/ | Sets the cleaning type for head cleaning.
Hard
Cleaning Check ON/OFF Sets whether nozzle checking is performed after head cleaning is
completed.
Interval Wiping OFF/3 to 255 | Wiping starts when the set print time is exceeded.
min
Refresh Weak/ Select the refresh (flushing) time during printing.
Standard/
Strong
Waste Ink Tank - Resets or corrects the waste ink tank usage count. (& "Waste Ink
Tank Replacement"(P. 158)
Reset Waste Ink - Resets the waste ink tank usage count. (2” "Replacing the lower-
Tank Volume left waste ink tank"(P. 158)
Adjust Waste Ink - Corrects the waste ink tank usage count. (& "When "Check Waste
Volume Ink Tank" message appears"(P. 158)
Tank Capacity - Displays the waste ink tank capacity.
Air PG - Expels any air in the ink paths.
» Use this if Ink End is still displayed after ink replacement.

*1. The default settings are shown underlined.
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Registering Nozzle Recovery

Allows other nozzles to be used for printing if maintenance actions like nozzle washing fail to resolve ejection
failures (e.g., nozzle clogging or deflection).

L+ Nozzle recovery can be specified for up to 20 nozzles per row. The time taken for printing
= remains unchanged even when nozzle recovery is set.

» Load media at least 500 mm wide. You cannot print the entire pattern if media less than 500
mm wide is used.

1 Position the media.

2 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

» The Maintenance menu is displayed.

3 Select [Nozzle Recovery] > [Print], then press the [ENTER] key.

* Print a nozzle recovery pattern.
» The Select Entry Nozzle screen appears once printing is complete.

10 5 0
100 90 80 70 60 50 40 30 20 10 0 T ——— 401
H1-D K =30t

E ——+O—la HI-A
3 H1-C Y L —T—__ 101
m‘ T —L 1
x
5 8 ¢ N0.203
< L Nozzle row number

< > Head number

Approx. 300 mm

4 Select the "head number and nozzle row" for nozzle recovery, then press the [ENTER] key.

SELECT ENTRY NOZZLE

Head1{A
Head1{B
Head1|C
Head1{D
Head1{E

5 Enter the "nozzle number” for nozzle recovery, then press the [ENTER] key.

Head number Nozzle row number

V V V|V V

 Select the entry number before entering the nozzle number.

* Nozzle recovery is set.
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6 Press the [ENTER] key once entry is complete.
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\ /

~~ ° Select [Maintenance] > [Nozzle Recovery] > [Test Print], then select "ON" to perform
g‘ nozzle recovery and test printing. (& "Test Printing"(P. 94)

Nozzle Check

This is used to check for nozzle clogging before printing starts. Sets whether to perform maintenance
functions automatically if nozzle clogging is detected.

| [Printing Check]

| oN

| Nozzle check (nozzle clogging detection)

[Judgment Condition] setting for nozzle clogging

| dete:

ction

|—>| The nozzles are not checked. l—
OFF

If = the set value

[Nozzle Recovery] (cleaning followed by nozzle
checking)
* Repeated by [Retry Count] cycles.

| [Judgment Condition] setting for nozzle clogging

dete

ction

) If 2 the set value

| Stop Printing
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| If less than the set value

If less than the set value

[Auto Nozzle Recovery] l—»
OFF

{ on

| Performs nozzle recovery automatically. |

\4

| Continue Printing |<7
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3.3 Function Setting Menu

This is used to set various operations to ensure optimal machine performance.

® Menu List
Item Setting*1 Details
Logical Seek Host/OFF/ON | Sets the range of carriage movement.
* ON: Print data area
Unidirectional printing Bi-directional printing
‘;: =
Print data
Carriage movement
Option Roll Unit Select - Selects the roll unit used.
Feeding unit ON/OFF Set to "OFF" if the feeding unit is not used.
Feed tension bar ON/OFF Displayed when the feeding unit is on. Set to "OFF" if the
feeding tension bar is not used.
Take-up Unit ON/OFF Set to "OFF" if the take-up unit is not used.
Take-up tension bar N/OFF Displayed when the take-up unit is on. Set to "OFF" if the take-

up tension bar is not used.

Feeding/take-up

Continuous/

Set the operation to assign to the feeding/take-up switch.

switch Temporary + Continuous: Operation continues until the switch is pressed
again.
» Temporary: Operates only while the switch is pressed.
When the direct-connection unit is is attached, feeding/take-up
only continues as long as the switch is pressed, regardless of
the continuous/temporary setting.
Tension roller ON/OFF * ON: The tension roller operates for printing even when the
platens are used. 2
Take-up diameter AUTO/ Sets the method for detecting the media outer diameter for the
detection MANUAL take-up unit and feeding unit.
Drying Time - Sets the time for ink to dry.
Scan Host/0.0 to | Sets the stop time of the carriage after each scan.
9.9 sec + The MIMAKI RIP software (RasterLink) indicates this as
"Pause Time per Scan".
Print End Host/0 to 120 | Sets the stop time after printing. The next data is printed once
min the set time has elapsed.
* The Mimaki RIP software (RasterLink) does not allow the
user to specify Print End. If the machine is set to "HOST",
the time will be "0".
Power Setting - Sets the times to turn the power on and off automatically.
Auto Power-off 5to 15to 60 |Sets the time until the power is automatically turned off.
min

Auto Power-on

Sets the time to automatically turn on the power.
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Item Setting*1 Details

Setup ON/OFF Sets whether to turn on or off the power.

Time 0:00 to 23:59 | Sets the time to turn on the power.

Day Monday to | Sets whether to turn on or off the power on each day of the

Sunday week.

Nozzle Check ON/OFF Automatically executes the nozzle check function when the
machine is started with auto power-on. Performs nozzle
recovery (cleaning followed by nozzle checking) if "nozzle
clogging" is detected.

Cleaning Soft/Normal/ | Sets the cleaning type.
Hard
Retry Count 0 to 3times |Performs nozzle recovery (cleaning followed by nozzle
checking) for the specified number of times.
Top Blower ON/OFF Sets the blowing fan operation during printing.
Strength AUTO/Low/ |Sets the blowing fan wind strength.
High

WhiteSpace Setting

Margin

Margin/Left

Host/-10 to 85

Sets the offset value from the media left and right standard
margins (15 mm).
* The left and right margins should be set to at least -5 mm
when using the media holder. This eliminates the risk of
printing on top of the media holder.

Marain/Riaht mm « The Mimaki RIP software (RasterLink) does not allow the
9 9 user to specify margins. If the machine is set to "Host", the
offset value will be "0 mm" for the left and right margins.
Space Btwn PP. None/10 to | The space between prints can be eliminated for continuous
500 mm printing.

* Reducing the space length may cause media sagging,
resulting in discrepancies in the distance the media is fed.

Space Feed Mode

Intermittent/

Alters the feed method for blank space included in the image

Continuous |data.
 Intermittent: Uses intermittent feeding based on the timing of
a fraction of the pass.
» Continuous: Feeds forward by skipping blank parts.
View Feed ON/OFF Sets whether or not to feed the media forward to view the print
results—for example, during test printing.
Auto Remote ON/OFF Sets whether to automatically switch to REMOTE mode and

start printing if data is received locally.

*1. The default settings are shown underlined.
*2. If the platens are not fitted, the tension roller will operate regardless of this setting.

117




Chapter 3 Setup

3.4 Environment Setting Menu

This is used to set various operations to ensure optimal machine performance.

® Menu List
Item Setting*1 Details
LANGUAGE English / B 7 | Sets the display language.
§ / Deutsch /
Portugués /
Espaiiol /
Italiano /
Korean
Time Set -20 to 0 to +4 | Sets the current time and date. (With respect to JST)
h + This can be set within the range of -20 to +4 hours.
Key Buzzer ON/OFF Sets an audible tone when keys are pressed.
» Audible signals indicating errors, warnings, and operation end
cannot be muted, even if "OFF" is selected for this setting.
Unit Setting - Set the display units.
Temp. °C/°F Sets the display unit for temperature (Celsius/Fahrenheit).
Length mm/inch Sets the display units for length and area.
» Some items are displayed in "mm" even if "inch" is selected.
Network - Sets the network address. The machine must be restarted to enable
this setting.
Check IP - Displays the machine's current IP address.
Address + It may take some time to determine the IP address. If the IP
address cannot be determined, the display will indicate "0.0.0.0".
Check MAC - Displays the machine's current MAC address.
Address
DHCP ON/OFF Select "ON" to use the IP address assigned by the DHCP server.
AutolP ON/OFF Select "ON" to use the IP address set by the AutolP protocol. Note
that DHCP takes priority if DHCP is set to "ON".
Ip Address - Sets the IP address used by the machine.
» This can be set when both [DHCP] and [AutolP] are disabled.
Default Gateway - Sets the default gateway used by the machine.
» This can be set when both [DHCP] and [AutolP] are disabled.
DNS Address - Sets the DNS server address used by the machine.
» This can be set when both [DHCP] and [AutolP] are disabled.
Sub Net Mask - Sets the subnet mask used by the machine.
» This can be set when both [DHCP] and [AutolP] are disabled.
Remote Control - An application (MRA: Mimaki Remote Access) is required to use the
remote control function. MRA is a remote access tool installed on a
computer or smartphone that allows viewing of product information
and panel operation from a remote location away from the machine
(within the same network segment).
Setup Enable/ Enable/disable remote control.
Disable
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Item Setting*1 Details
PIN code 000 to 9999 |Enter the same PIN code as MRA. The PIN code is used for
authentication between the machine and MRA.
» When the machine is set to "0000", MRA can access the
machine with any PIN code.
KeyLife 5to 30 to 120 | Sets the time interval before disconnecting the machine and MRA if
min no operations are performed using MRA.

Machine Reset

Initializes the details set.

*1. The default settings are shown underlined.
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3.5 Machine Status Menu

This is used to check machine information.

® Menu List
Item Details
Usage WIPING The number of wiping cycles is displayed.

» To reset the number of wiping cycles, press the [FUNCZ2] key while the
level is displayed.

Print Length

Displays the total length printed.

Print Area Displays the total area printed.

Use Time Displays the total time the power has been turned on.

Capping Use [ Displays the number of days since the cap was replaced.

Days

Waste Ink Displays the approximate level of waste ink in the waste ink tank as a
Tank percentage.

To reset waste ink levels, press the [FUNC1] key while the level is displayed.

Maintenance

Displays a record of maintenance function execution (up to 10).

Maintenan + Cleaning (2 P. 96, Pump Tube Cleaning (& P. 131, Nozzle Washing
ce History & P. 166
Replace Displays a record of wiper replacement (up to 5). (& P. 143
Wiper
Ink Displays a record of ink pack replacement for each ink slot (up to 5).(&°
replacement | "Replacing Ink"(P. 42)
* Slot1to 8
Cap Displays a head cap replacement history. & "Cap Replacement"(P. 146)
Replacement
Version Displays the machine firmware and other versions.

Error History

Displays the error and warning history.

» These are listed in chronological order. Use the keys to cycle through
occurrence time/date and error/warning information.

List

This is used to print machine information.
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g This chapter
& To ensure years of precise performance, maintain the machine periodically based on

frequency of use.
Read the maintenance precautions thoroughly before maintaining this product.

Maintenance Precautions..............cccccvvvvnnnn. 122 Replacement of Consumable Item................. 142
Maintenance Methods ..............c.cccocvevevevnnn.n. 123 Consumable Item Replacement Timing....142
Maintenance Iltems and Timing ................ 123 W!per Replacement ..................................143
Ink Maintenance..............cccoveeveeeeeeeennn 124 Wiper Cleaner Replacement..................... 144
Cap Rubber Cleaning...........ccoo.oovveevvvee.... 124 Cap Replacement .................................. :...146

Carriage Underside Cleaning................... 125 Replacing the Absorber Around the Station
Wlper Cleanlng ----------------------------------------- 126 ....................... 148
NCU ClEANING ....veoveeeeeeeeeeeeeeeeeeeeeree. 128  Exhaust Fan Filter Replacement...............150
DAS (Automatic Correction Function) Sensor B!owmg Fan Filter Replacement...............150
Cleaning ......ccccoccveeeeeeeieee e 129 Pinch Roller Replacement .......................151
Ink-Receiving Pan Spacer Cleaning ........ 130 Media Holder and Cloth Holder Replacement
Ink Slope Cleanlng ................................... 131 ...................... 153

Ink Discharge Channel Cleaning.............. 131 Ink Supply Unit Ink Absorber Replacement
Medla Sensor Cleanlng ........................... 132 157
Waste Ink Tank Replacement...................158

Media Holder and Cloth Holder Cleaning. 132
Jam Sensor Detecting Plate Cleaning ..... 134

Platen and Platen Wire Cleaning............. 135
Pinch Roller and Grit Roller Cleaning ...... 135
Tension Roller Cleaning..........ccccoecuvvieee. 136
Blowing Fan Filter Cleaning ..................... 137
Cover (Exterior) Cleaning..........ccccceveeenn. 139

When this Printer is Left Unused for a Long
TIMe (o 139
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4.1 Maintenance Precautions

This machine includes parts that must be replaced periodically. We therefore recommend taking
out a maintenance contract. Carry out maintenance periodically and replace consumable items
to prevent quality defects and accidents.

/\ WARNING

>

Clean periodically. Debris and dust will accumulate on electrical components when the machine
is used for extended periods. There is a risk of failure, electric shock, or fire due to current
leakage.

Do not clean by blowing—e.g., avoid using air blowers. Doing so may lead to failure, electric
shock, or fire involving the machine if airborne debris or dust gets inside electrical components.
Wipe using a soft cloth soaked in diluted neutral detergent and thoroughly wrung out. A vacuum
cleaner may also be used for cleaning.

%

Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
electric shock, or fire.

/\CAUTION

For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.

PSSO

Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

NOTICE

%,

Never touch the print head nozzle surface. Do not allow water or alcohol to come into contact
with the print nozzle surface. This will increase the risk of machine failure or ejection failures
(e.g., nozzle clogging or deflection).

Do not use cotton swabs to clean around the head or carriage. Fibers from cotton swabs may
adhere to the head nozzle surface and lead to ejection failures (e.g., nozzle clogging or
deflection).

Do not splash ink or maintenance liquid on the covers. Exposure to splashing ink or
maintenance liquid may damage or deform the cover.

Do not use benzine, thinner, or any chemical agent containing abrasives. Use of these
chemicals may result in damage to or deformation of parts.

Do not use organic solvents such as acetone and IPA. Doing so may damage the machine.
Do not move the carriage by hand. To move the carriage, use the carriage out function on the
menu.
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4.2 Maintenance Methods

Maintenance Items and Timing

Timing Item

Every day after work Clean around the wiper. (2& "Wiper Cleaning"(P. 126)

Every three days, at the | Shake the ink. (&" "Ink Maintenance"(P. 124)
start of the work

Every three days after |Dispose of ink in the waste ink tank in the lower left of the machine. (2&° "Waste

work Ink Tank Replacement"(P. 158)
At the end of the week's | Clean the cap rubber. @& "Cap Rubber Cleaning"(P. 124)
work

Clean the underside of the carriage. & "Carriage Underside Cleaning"(P. 125)

Check the waste ink levels in the waste ink tank. (&~ "When "Check Waste Ink
Tank" message appears"(P. 158)

Clean the ink discharge channel. (2 "Ink Discharge Channel Cleaning"(P. 131)

At the end of two Clean the blowing fan filter. (25 "Blowing Fan Filter Replacement"(P. 150)
weeks' work

When the media is Clean the ink-receiving pan spacers. & "Ink-Receiving Pan Spacer
replaced Cleaning"(P. 130)

Clean the tension roller. (22 "Tension Roller Cleaning"(P. 136)
Clean the ink slope. (& "Ink Slope Cleaning"(P. 131)
Every month Clean the NCU. (2&° "NCU Cleaning"(P. 128)

Clean the DAS sensor. (& "DAS (Automatic Correction Function) Sensor
Cleaning"(P. 129)

Clean the media sensor. &~ "Media Sensor Cleaning"(P. 132)

Clean the media holders and cloth holders. (22 "Media Holder and Cloth Holder
Cleaning"(P. 132)

Clean the jam sensor detecting plate. (& "Jam Sensor Detecting Plate
Cleaning"(P. 134)

Clean the platen. (& "Platen and Platen Wire Cleaning"(P. 135)

Clean the pinch rollers and grit rollers. & "Pinch Roller and Grit Roller
Cleaning"(P. 135)

Clean the cover (exterior). (& "Cover (Exterior) Cleaning"(P. 139)

When not used for Clean the cap and wash the ink discharge channels. After cleaning, store without
more than a week turning off the main power supply. (& "When this Printer is Left Unused for a
Long Time"(P. 139)

Items Required for Maintenance

To order replacement consumable items, contact your local dealer or our service office. For more information
on consumable items, refer to our website (https://mimaki.com/supply/inkjet.html).

® » Do not store consumable items in locations where children may enter.
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Ink Maintenance

If ink constituents are sedimented, the ink density may become uneven. We recommend shaking the ink
periodically to keep printing consistent.

Once every three days.

» Shake taking care that the ink eco-cases do not become detached from the ink supply unit.
Ink may leak out if the ink eco-cases become detached.

1 Shake the ink eco-cases slowly approximately 10 times.

» Shake the ink eco-cases back and forth while holding the top.

» Be sure to shake the ink eco-case back and forth by holding its top. Ink may leak out if the
top is not held and the ink eco-cases become detached.

Cap Rubber Cleaning

The cap prevents the print head nozzle surface from drying out. Continuing to use a dirty cap may affect ink
take-up and lead to ejection failures (such as nozzle clogging or deflection).

» Be careful to avoid leaving fragments from the cleaning stick behind when cleaning. These
fragments will increase the risk of ejection failures (e.g., nozzle clogging or deflection).

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.
» The Maintenance menu is displayed.
Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.

» The carriage moves over the platen.

3 Open the maintenance cover on the right side.

e 2 \)
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4 Clean the cap rubber.

» Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

» Clean the areas indicated in red in the diagram (the entire interior and exterior of the cap rubber,
the tabs, and the mesh retainers).

5 Close the maintenance cover, then press the [ENTER] key.

Carriage Underside Cleaning

The underside of the carriage becomes coated with ink wiped off by the wiper. Continuing to use the dirty
carriage underside will rub dried ink and attached dust on to the media, resulting in contaminated prints.

The print head uses an extremely delicate mechanism. Take great care when handling it.

» Be careful to avoid leaving fragments from the cleaning stick behind when cleaning. These
fragments will increase the risk of ejection failures (e.g., nozzle clogging or deflection).

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

» The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Maint. Space], then press the [ENTER] key.

» The carriage moves to the maintenance space.

3 Open the maintenance cover on the left side.
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4 Clean around the print head.

» Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

Clean the print head sides and all around the nozzle plate using a cleaning stick.

Never touch the

nozzles
u\f&\

Clean using a cleaning stick or soft cloth.

® » Never touch the print head nozzles (areas indicated in blue in the diagram).

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

Wiper Cleaning

The wiper wipes off ink adhering to the print head nozzle surface. Continuing to use with a dirty wiper will

cause dried ink and attached dust to rub against the head nozzle surface, and lead to ejection failures (e.g.,
nozzle clogging or deflection).

» Be careful to avoid leaving fragments from the cleaning stick behind when cleaning. These
fragments will increase the risk of ejection failures (e.g., nozzle clogging or deflection).

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.
» The Maintenance menu is displayed.

Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.

» The carriage moves over the platen.

3 Open the maintenance cover on the right side.
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4 Remove the wiper.

» Hold the lug at the rear of the wiper bracket, then pull out the wiper.

Lug

5 Clean the wiper and bracket.

» Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

0 + Replace dirty or warped wipers with new ones. Wiper Replacement

6 Clean the wiper slider.

» Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.
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7 Reattach the wiper at the original position.

< 7 [
/ Projection
i g
Q
0 /

8 Once cleaning is complete, close the cover, then press the [ENTER] key.

NCU Cleaning

The NCU uses a sensor to monitor the ink droplets ejected from the print head nozzles. Continuing to use
the dirty NCU may prevent the nozzle check function from operating correctly.

* Be careful to avoid leaving fragments from the cleaning stick behind when cleaning. These
fragments will increase the risk of ejection failures (e.g., nozzle clogging or deflection).

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.
» The Maintenance menu is displayed.
Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.

» The carriage moves over the platen.

3 Open the maintenance cover on the right side.

[ ®@ \)
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4 Clean the NCU.

» Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

DAS (Automatic Correction Function) Sensor Cleaning

The DAS sensor is located on the carriage underside. If dust or debris accumulates on the sensor, DAS
(& P. 108) may not function.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

» The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Maint. Space], then press the [ENTER] key.

» The carriage moves to the maintenance space.

3 Open the maintenance cover on the left side.

129




Chapter 4 Maintenance

4 Clean the DAS sensor.

» Wipe clean using cotton swabs or a soft cloth.

» For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and
thoroughly wrung out.

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

Ink-Receiving Pan Spacer Cleaning

Remove the spacers and wash them to remove any ink adhering to the ink-receiving pan spacers, for
example when replacing the media.

Q » Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
% electric shock, or fire.

* Do not pour water directly over the ink-receiving pan spacers while they are mounted on
the machine.

« For heavy soiling, remove the ink-receiving pan spacers, then wipe using a soft cloth soaked in
diluted neutral detergent and thoroughly wrung out.

® * Do not use organic solvents such as acetone and IPA. Doing so may damage the machine.
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Ink Slope Cleaning
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% » Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
% electric shock, or fire.
* Do not pour water directly over the ink slope.

» For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.

® * Do not use organic solvents such as acetone and IPA. Doing so may damage the machine.

Ink Discharge Channel Cleaning

Clean the ink discharge channel regularly to prevent clogging of the ink discharge channel below the cap.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

» The Maintenance menu is displayed.

2 Select [Station Maint.] > [Pump tube cleaning], then press the [ENTER] key.

» The cap is filled with maintenance liquid.

» Close the cover. The cap cannot be filled with maintenance liquid while the cover is open.
This is also true if the maintenance liquid cartridge is empty.

3 Open the maintenance cover on the right side.

SN

» Check to confirm that approximately half a capful of maintenance liquid remains.

131



Chapter 4 Maintenance

\g/  If not, use a syringe to draw up some maintenance liquid and drip in approximately half a
capful.

» Check to confirm that there is approximately half a capful of maintenance liquid inside.

\Q/  If not, use a syringe to draw up some maintenance liquid and drip in approximately half a

- capful.

4 Close the maintenance cover, then press the [ENTER] key.

» Pump tube (ink discharge channel below the cap) washing starts.

Media Sensor Cleaning

Media sensors are located on the rear pre-covers (2 locations). The media cannot be detected correcily if
dust or debris accumulates on the sensors. Remove any debris using cotton swabs or a soft cloth.

[Rear 6f prE)Euct] @D
—
0

Media Holder and Cloth Holder Cleaning

Continuing to use the dirty platen will prevent proper feeding of the media. It will also cause dried ink and
attached dust to rub against the head nozzle surface and lead to ejection failures (e.g., nozzle clogging or
deflection).

%\
Cloth holder

<

SN
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Turn off the main power supply and unplug the power cable before carrying out maintenance.

Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
electric shock, or fire.

For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.

VeVe

Do not use organic solvents such as acetone and IPA. Doing so may damage the machine.
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Jam Sensor Detecting Plate Cleaning

Continuing to use the dirty carriage underside will rub dried ink and attached dust on to the media, resulting
in contaminated prints.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

» The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Maint. Space], then press the [ENTER] key.

» The carriage moves to the maintenance space.

3 Open the maintenance cover on the left side.

4 Clean the jam sensor detecting plate.

» Clean the jam sensor detecting plate underside at the left and right sides of the carriage.

» Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

5 Once cleaning is complete, close the cover, then press the [ENTER] key.
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Platen and Platen Wire Cleaning

Continuing to use the dirty platen will prevent proper feeding of the media. It will also cause dried ink and
attached dust to rub against the head nozzle surface and lead to ejection failures (e.g., nozzle clogging or
deflection).
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Platen wire
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« Turn off the main power supply and unplug the power cable before carrying out maintenance.

Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
electric shock, or fire.
+ Do not pour water directly over the platens.

2 -

—
I~

\ /
N

The grooves in which the media holder slides and the media is cut are susceptible to dust
accumulation. Remove any debris carefully.

» For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.

Do not use organic solvents such as acetone and IPA. Doing so may damage the machine.

0/®

Pinch Roller and Grit Roller Cleaning

Continuing to use the dirty platen will prevent proper feeding of the media. It will also cause dried ink and
attached dust to rub against the head nozzle surface and lead to ejection failures (e.g., nozzle clogging or

deflection).

I
2

» Turn off the main power supply and unplug the power cable before carrying out maintenance.

electric shock, or fire.

» Do not use organic solvents such as acetone and IPA. Doing so may damage the machine.

‘ » Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
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® For grit rollers
1 Open the front cover.

2 Raise the clamp lever.

3 Remove any dirt from the grit rollers by gently brushing several times with a plastic brush.

» Brush the entire circumference by rotating the right-hand side of the grit rollers with your fingers.

\
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* Wipe the ends of the dirt brush clean with a dry cloth.
« [f the dirt resists removal, wet the brush with water.

+ Be sure to use a plastic brush to clean the grit rollers.
Wiping with cloth or paper towels will result in fibers catching and adhering to the rough

surfaces. Using a wire brush will damage the grit rollers and prevent correct feeding.
« After brushing with water, feed a piece of scrap media through to remove any moisture.

® For pinch rollers
Use a cloth to remove any ink or other dirt from the pinch roller surfaces.

» For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly

0 wrung out.

Tension Roller Cleaning

'

o
/

» For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly

0 wrung out.

136



Chapter 4 Maintenance

Blowing Fan Filter Cleaning

Wash the blowing fan filter in water if it is dirty.

® Recommended cleaning guide

+ Check the filter for dirt every two weeks, and wash.
+ Replace the filter every three months. <& "Blowing Fan Filter Replacement"(P. 150)

0 * Turn off the main power and unplug the power cable before replacement.

1 Remove the fan filter cover.

» Push the fan filter cover claw outward, and pull the cover to the front.

Fan filter cover

L

2 Remove the filter.

3 Wash the filter.

0 + Dry the filter after washing.
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4 Attach the dry filter together with the fan filter cover.

e Push in the fan filter cover until the tab clicks.
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Cover (Exterior) Cleaning

Q » Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
% electric shock, or fire.

» For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.

When this Printer is Left Unused for a Long Time

Clean as follows if the product is not used for one week or longer:

Check beforehand

Is [Near End] or [Ink End] displayed?
« Maintenance liquid and ink is aspirated during the washing operation. Washing is not possible if an
error occurs during this process. Replace with new ink.

* Do not turn off the main power supply. Turning off the main power supply will disable the
automatic maintenance function (including nozzle clogging prevention function and ink
discharge channel cleaning function). This increases the risk of ejection failures (such as nozzle
clogging or deflection).

AN
r

® * Do not leave media loaded on the platen. This may leave irregularities or ripples in the media.

When the machine is not in use, raise the clamp lever to separate the pinch rollers from the grit
rollers.
» Leaving the pinch rollers lowered may cause them to become deformed and prevent media from
being fed correctly.
» Leaving media loaded will subject it to force from the pinch rollers, which may leave pinch roller
marks on it.

machine.

0  If Check Waste Ink is displayed, dispose of ink in the waste ink tanks on the left and right of the
& "Waste Ink Tank Replacement"(P. 158)
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1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

» The Maintenance menu is displayed.

2 Select [Station Maint.] > [Custody Wash], then press the [ENTER] key.

» The carriage moves over the platen.

3 Open the maintenance cover on the right side.

"o @\

4 Clean the cap rubber.
« (& "Cap Rubber Cleaning"(P. 124)

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

» The cap is filled with maintenance liquid.

» Close the cover. The cap cannot be filled with maintenance liquid while the cover is open.
This is also true if the maintenance liquid cartridge is empty.

6 Open the maintenance cover on the right side.

» Check to confirm that the cap is filled with maintenance liquid.

\Q/ * If not, use a syringe to draw up some maintenance liquid and fill until it almost overflows

- from the cap.

7 Close the maintenance covers.

8 Set the exposure time, then press the [ENTER] key.

» Cleaning is performed automatically once print nozzle washing has ended.
» The cap is filled with maintenance liquid.

9 Open the maintenance cover on the right side.

» Check to confirm that there is approximately half a capful of maintenance liquid inside.
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 If not, use a syringe to draw up some maintenance liquid and drip in approximately half a

v

capful.

3

N\,

1 0 Close the maintenance cover, then press the [ENTER] key.

* Pump tube (ink discharge channel below the cap) washing starts.
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4.3 Replacement of Consumable ltem

To order replacement consumable items, contact your local dealer or our service office. For more information

on consumable items, refer to our website (https://mimaki.com/supply/inkjet.html).

@ * Do not store consumable items in locations where children may enter.

i

* When disposing of consumable items, contact an industrial waste disposal operator or dispose
of the product in accordance with the local laws and regulations.

Consumable Item Replacement Timing

Timing

Item

When dirty

¥ "Replacing the Absorber Around the Station"(P. 148)
& "Wiper Replacement"(P. 143)

(&~ "Exhaust Fan Filter Replacement"(P. 150)

& "Blowing Fan Filter Replacement"(P. 150)

When ejection failures cannot be
remedied

& "Cap Replacement"(P. 146)
& "Wiper Replacement"(P. 143)

When damaged

& "Wiper Replacement"(P. 143)

& "Cap Replacement"(P. 146)

& "Pinch Roller Replacement"(P. 151)

" "Media Holder and Cloth Holder Replacement"(P. 153)

When replacing ink

& "Ink Supply Unit Ink Absorber Replacement"(P. 157)

When "Replace Wiper" appears on
the display

& "Wiper Replacement"(P. 143)

When "Check Waste Ink Tank"
appears on the display

& "Waste Ink Tank Replacement"(P. 158)

Once a year

(&~ "Wiper Cleaner Replacement"(P. 144)
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Wiper Replacement

The machine maintains a count of the number of wiping cycles. The "Replace Wiper" message appears
when a preset count is reached. Replace dirty or warped wipers with new ones.

1 "Replace Wiper" appears on the display.

2 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

» The Maintenance menu is displayed.

3 Select [Station Maint.] > [Replace Wiper], then press the [ENTER] key.

» The carriage moves over the platen.

4 Open the maintenance cover on the right side.

5 Remove the wiper.

* Hold the lug at the rear of the wiper bracket, then pull out the wiper.

Lug
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6 Clean the wiper slider.

» Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

7 Mount a new wiper.

[
~~, Projection

7

\

8 Once replacement is complete, close the cover, then press the [ENTER] key.

» The wiper usage count is reset.

Wiper Cleaner Replacement

Replace with a new wiper cleaner (SPC-0243) once a year.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.
» The Maintenance menu is displayed.
Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
» The carriage moves over the platen.
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3 Open the maintenance cover on the right side.

Ny

TN,
o=,

» Hold the lugs on the fitting, then pull off.

» Take care to avoid losing the rubber seal.
5 Remove the wiper cleaner.

+ Slide forward to remove.

4 Remove the fitting.
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6 Mount a new wiper cleaner.

» Slide to the rear to attach it.

7 Reattach the fitting.

» Improper attachment may result in leaking maintenance solution.

8 Once replacement is complete, close the cover, then press the [ENTER] key.

Cap Replacement

If ejection failures (e.g., nozzle clogging or deflection) remain unresolved even after cleaning, replace with a
new cap.

0 » Be sure to replace the cap if you observe any scratches or other damage on the rim.

* When using Sb or TP ink for extended periods, the cap surface is susceptible to drying out,
which can lead to path clogging. If this occurs, either replace the cap or remove and wash it.

\Q/ * We recommend replacing the cap every six to twelve months.

= (TP ink: every six months, other ink: every twelve months)

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

» The Maintenance menu is displayed.
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2 Select [Station Maint.] > [Replace Cap], then press the [ENTER] key.

» The carriage moves over the platen.

3 Open the maintenance cover on the right side.

QAo ®@ \)

4 Remove the cap.

» Squeeze the lugs on either side of the cap and pull off.

[When using Sb ink and TP ink] Rinse the cap with the mesh side facing downward in a
container filled with maintenance liquid. Remove, then wipe clean the resin part thoroughly.

6 Apply maintenance liquid.

» Use a syringe to apply two or three drops of maintenance liquid to the hole at the front.
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7 Mount a new cap or a cap that has been washed.

» Position with the slot at the front and push in until it clicks.

8 Once replacement is complete, close the cover, then press the [ENTER] key.

Replacing the Absorber Around the Station

If the cap absorber or maintenance liquid absorber is very dirty or if ink drips on to the media, replace with a
new cap absorber.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.
» The Maintenance menu is displayed.
Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.

» The carriage moves over the platen.

3 Open the maintenance cover on the right side.

Qe ®@ )
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4 Remove the two screws, then remove the cap cover.

» Slide to the rear to detach the tabs at the front.

5 Remove the cap absorber.

0 * Avoid ink dripping when removing the cap absorbers.

6 Mount a new cap absorber.

* Insert the tabs on the plate into the slits in the cap absorber.

o » Check to confirm that the cap absorber does not become detached.

7 Remove the maintenance liquid absorber.

8 Wipe away any maintenance liquid from around the slider block.

9 Mount a new maintenance liquid absorber.

» Push firmly on to the protrusion.

1 0 Check to confirm that the absorber is not lifting or curved.
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1 1 Insert the two screws to secure the cap cover in place.

1 2 Once replacement is complete, close the cover, then press the [ENTER] key.

Exhaust Fan Filter Replacement

Check the exhaust fan filter condition. Replace if very dirty.

1 Remove the exhaust fan box.

« Push the tabs at the front to remove the exhaust fan box.

0 * Replace the very dirty exhaust fan box with new one.

2 Mount a new exhaust fan filter in the exhaust fan box.

* Press the exhaust fan filter into the space under the tabs of the exhaust fan box.

3 Mount the exhaust fan box.

* Insert the tabs of the exhaust fan box into the slits of the machine, and clip in the tabs at the front.

Blowing Fan Filter Replacement

Replace the blowing fan filter if it is dirty.

If sublimation transfer ink is used
* Replace the filter every three months.

0 « Turn off the main power and unplug the power cable before replacement.
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1 Remove the fan filter cover.

» Push the fan filter cover claw outward, and pull the cover to the front.

s N

Fan filter cover

2 Remove the filter.

e

>) Blowing fan filter

3 Mount a new filter and the fan filter cover.

e Push in the fan filter cover until the tab clicks.

Pinch Roller Replacement

Replace worn or dirty pinch rollers with new ones.

If sublimation transfer ink is used
* Replace the pinch rollers every month if used for approximately 12 hours per day.
» Replace the pinch rollers every two weeks if used 24 hours per day.

0 « Turn off the main power and unplug the power cable before replacement.

1 Open the front cover.
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2 Raise the clamp lever.

3 Remove the O-ring retaining the pinch rollers.

Q » The pinch rollers are small. Be careful to avoid dropping them into the product interior.

4 Remove the pinch rollers or the pinch roller spindle.

5 Mount new pinch rollers, and secure them using the O-ring.

6 Close the front cover.
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Media Holder and Cloth Holder Replacement

If the media holders or cloth holders become deformed and touch the carriage or print head, replace with
new media holders or cloth holders.

0 « Turn off the main power and unplug the power cable before replacement.

® For media holders

This is the procedure for replacing the left-hand media holder. Replace the right-hand media holder in the
same way.

1 Open the maintenance cover on the left side.
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3 Remove the media holder.

4 Remove the sliders from the media holder.

» Be careful to avoid misplacing the sliders.

5 Mount the sliders on to the new media holder.

» Engage the holes in the sliders on to the lugs on the media holder.
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7 Secure the media holder stopper with the screw.

8 Close the maintenance covers.
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® For cloth holders

1 Open the left and right maintenance covers.

3 Mount new cloth holders.

» Note the orientation of the left and right cloth holders. Attach so that the screws are facing
outward. Note also that the cloth holders are shaped differently at the front and rear.

4 Close the maintenance covers.
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Ink Supply Unit Ink Absorber Replacement

We recommend replacing the ink absorber each time you replace the ink pack, to prevent dirt building up on
the pedestal of the ink supply unit.

5 » Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

1 Push down the lever on the pedestal, and remove the ink Eco-case.

/\4

/\4
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Waste Ink Tank Replacement

The ink used in printing and head cleaning is stored in the waste ink tanks on the right and left sides of the
machine.

\Q/ + For a 2-liter tank, the preset level is 80 % (1.6 L).

- + Continuing to use the product without disposing of the waste ink may result in waste ink
overflowing from the waste ink tank. Visually check ink levels in the waste ink tank about once a
week.

» Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
o1

handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking

ink may adhere to the skin or get into the eyes or mouth.

When "Check Waste Ink Tank™ message appears

1 The "Check Waste Ink Tank" message appears on the display.

Check Waste Ink tank
Level: xx %

2 Check the waste ink levels in the waste ink tank.

« If you note any discrepancies from actual levels, proceed to the next step.

« If there is no discrepancy, replace (dispose of) the waste ink tank referring to & "Replacing the
lower-left waste ink tank"(P. 158).

On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

w

» The Maintenance menu is displayed.

Select [Waste Ink Tank], then press the [ENTER] key.

Select [Adjust Waste Ink Volume], then press the [ENTER] key.

o 0 A

Press &) (¥ to adjust the level.

7 Press the [ENTER] key once adjustment is complete.

Replacing the lower-left waste ink tank

® Lower-right waste ink tank replacement

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

» The Maintenance menu is displayed.

2 Select [Waste Ink Tank], then press the [ENTER] key.

3 Select [Reset Waste Ink Volume], then press the [ENTER] key.
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4 Hold the handle on the waste ink tank and slide out.

* When disposing of ink, maintenance liquid or other liquid used with the product, or
containers or non-woven fabric contaminated with ink or other liquid, contact an industrial

waste disposal operator or dispose of the product in accordance with the local laws and
regulations.
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Replacing the lower-right waste ink tank

® Lower-right waste ink tank replacement

1 Remove the waste ink tank.

(1) Pull the lug of the waste ink tank holder and push the holder open.

Waste ink tank holder

Waste Ink Tank
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2 Replace the waste ink tank.

(1) Prepare a new waste ink tank (SPA-0277).
(2) Holding the waste ink tank by the handle, insert it in the holder.

New waste ink tank

* When disposing of ink, maintenance liquid or other liquid used with the product, or
containers or non-woven fabric contaminated with ink or other liquid, contact an industrial

waste disposal operator or dispose of the product in accordance with the local laws and
regulations.
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Chapter 5 Troubleshooting

5.1 Troubleshooting

For information on troubleshooting, refer to this chapter. Refer to our website (https://mimaki.com/support/)
for frequently asked questions (FAQs) about this product and customer support videos.

If the recommended corrective action does not resolve the problem, contact your local dealer or our service

office.

The power does not turn on.

Points to check

Corrective action

Is the power cable connected to the
machine?

Insert the power socket until it clicks into place.

Are you using the power cable
provided?

Use the power cable provided.

Is the main power supply turned on?

Turn on the main power supply. (& "Turning On the Power"(P. 33)

Is the [END/POWER] key on the
operating panel turned on?

Turn the power on. (25 "Turning On the Power"(P. 33)

Printing is not possible.

Points to check

Corrective action

Is a USB interface cable connected?

Connect the cable securely to the USB 2.0 port. (25 "Using a USB
Cable"(P. 37)

Is a LAN cable connected?

Connect the cable securely to the LAN port. (2° "Using a LAN
Cable"(P. 36)

Are you using a LAN cable approved
by Mimaki?

Check the LAN cable type. & "Using a LAN Cable"(P. 36)

Is the status lamp on the operating
panel illuminated or flashing red?

An error has occurred. Check the message on the display. (&~
"Operating Panel"(P. 30)

The media jams or the media is dirty.

Points to check

Corrective action

Are you using the recommended
media?

Make sure you are using the recommended media. https://
mimaki.com/supply/inkjet.html

Are you using curled media?

Do not use curled media or media with folded ends.

Is the media skewed?

Use the take-up unit to adjust the media or reload the media. &°
"Loading the Media"(P. 61)
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Points to check

Corrective action

Does the media have ripples/surface
irregularities or lift up?

If you are using roll media, use a smooth section of the media for
initial feeding. You can also improve this problem by attaching the

NITOFLON® tape provided on the platen.

k Be careful not to cover the vac‘uij“m‘hole\s. — |
For more information, refer to the description on transporting media
on the platen. https://mimaki.com/download/inkjet.html

Image defects occur.

Symptom

Corrective action

White streaks, blurriness, and dark
streaks occur.
(Carriage scan direction)

1. Remove any paper scraps or other debris adhering to areas over which
the head passes (e.g., media holders). (25° "Media Holder and Cloth
Holder Cleaning"(P. 132)(&" "Platen and Platen Wire Cleaning"(P. 135)

Perform the procedure described in (22~ "Head Cleaning"(P. 96).
Perform the procedure described in (28” "Feed Correction"(P. 97).
Perform the procedure described in (22" "Cap Rubber Cleaning"(P. 124).

Perform the procedure described in (22~ "Carriage Underside
Cleaning"(P. 125).

o~ wb

Text is double- or triple-printed in the
media feed direction.

1. Perform the procedure described in (22” "Feed Correction"(P. 97).

Offsetting occurs during bidirectional
printing.

1. Perform the procedure described in (25" "Correcting the Drop
Position"(P. 99).

Ink droplets drip during printing.

Perform the procedure described in (22" "Cap Rubber Cleaning"(P. 124).

2. Perform the procedure described in (2&” "Carriage Underside
Cleaning"(P. 125).

3. Perform the procedure described in (2" "Head Cleaning"(P. 96).

4. Set auto maintenance. & "Maintenance Menu"(P. 111)

Nozzles are clogged. 1. Perform the procedure described in (2Z” "Head Cleaning"(P. 96).

2. Perform the procedure described in & "Print Head Nozzle
Washing"(P. 166).

3. Perform the procedure described in (22” "Registering Nozzle

Recovery"(P. 114).

Are the print heads too high?

Adjust the print head height. & "Adjusting Print Head Height"(P. 56)
If the print heads cannot be lowered, increase the refresh level of
maintenance during printing (& "Maintenance Menu"(P. 111)) to
Standard or Strong and perform regular test printing to check for
nozzle clogging.

Are there any ink colors that aren't
used much?

Discharge from infrequently used nozzles tends not to be consistent.
Although increasing the refresh level of maintenance during printing
(% "Maintenance Menu"(P. 111)) to Standard or Strong will enable
more frequent nozzle use, note that this will also increase ink
consumption.
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Symptom

Corrective action

Are you using media easily affected
by static electricity?

Increase the refresh level of maintenance during printing (&~
"Maintenance Menu"(P. 111)) to Standard or Strong and perform
regular test printing to check for nozzle clogging.

Is the machine installed in a location
with low humidity?

Increase the humidity by installing a humidifier or similar equipment.
When printing continuously, also increase the refresh level of
maintenance during printing ((&° "Maintenance Menu"(P. 111)) to
Standard or Strong and perform regular test printing to check for
nozzle clogging.

Is the machine installed in a location
where dust or powder is present?

Install the machine in a location free of dust or powder (office
equivalent: dust level 0.15 mg/m3).

Print Head Nozzle Washing

If ejection failures (e.g., nozzle clogging or deflection) remain unresolved even after head cleaning (2
"Head Cleaning"(P. 96)), apply nozzle wash to the print head.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

» The Maintenance menu is displayed.

2 Select [Station Maint.] > [Nozzle Wash], then press the [ENTER] key.

» The carriage moves over the platen.

3 Open the maintenance cover on the right side.

4 Clean the cap rubber.

« (& "Cap Rubber Cleaning"(P. 124)

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

» The cap is filled with maintenance liquid.

» Close the cover. The cap cannot be filled with maintenance liquid while the cover is open.
This is also true if the maintenance liquid cartridge is empty.

6 Open the maintenance cover on the right side.

» Check to confirm that the cap is filled with maintenance liquid.

\ /

—

from the cap.

\g/ * If not, use a syringe to draw up some maintenance liquid and fill until it almost overflows

7 Close the maintenance covers.
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8 Set the exposure time, then press the [ENTER] key.

» Cleaning is performed automatically once print nozzle washing has ended.

* If ejection failures (e.g., nozzle clogging or deflection) remain unresolved even after
washing the nozzles several times, contact your local dealer or our service office.

The ink has leaked out

 If an ink leak occurs, turn off the main power immediately and unplug the power cable. Then,
contact your local dealer or our service office.
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5.2 Problems Causing Messages to

Appear

If a problem arises, the buzzer sounds and a message appears on the display.

You can also check the local guidance. &8 "Displaying Machine Information (Local Guidance)"(P. 32)

Take the appropriate action in accordance with the content of the message. If a message reappears even
after taking the prescribed action, contact your local dealer or our service office.

Warning Messages

Message

Cause

Corrective action

Replace NCU Ink Pad

The ink absorber needs to
be replaced.

The NCU ink absorber must be
replaced. Contact your local dealer or
our service office.

Replace NCU

A problem was detected
with the nozzle clogging
assessment.

NCU Sensor Lv Low

The sensor's sensitivity is
impaired.

NCU Sens Adj Err H

NCU Sens Adj Err L

Sensor sensitivity
adjustment failed.

Clean the NCU. (2" "NCU
Cleaning"(P. 128)

Replace the NCU if the error does not
clear. Contact your local dealer or our
service office.

NCU Connect

A problem was detected
with the NCU connection.

Turn off the main power and wait a
while before turning back on.

Ink Error An ink error occurred. Check the ink error details. (& "Ink
Error"(P. 170)
COVER OPEN The cover is open. Close the cover.

Lower the clamp lever

The clamp lever is raised.

Lower the clamp lever. &5
"Front"(P. 22)

Data Remain

Print (RIP) data was
received.

Switch to REMOTE mode and start
printing or clear the data and abort
printing.

Temporary Suspension

Printing has been paused.

Switch to REMOTE mode and resume
printing or clear the data and abort
printing.

Printing not possible/ink IC

An unusable ink IC chip is
used.

Replace with new ink and a new ink IC
chip. @& "Replacing Ink"(P. 42)

Cap Replacement

The cap usage count has
exceeded the specified
amount.

Replace the cap. (& "Cap
Replacement"(P. 146)

sensors are faulty.
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Replace Wiper The wiping count has Replace the wiper. (&~ "Wiper
exceeded the specified Replacement"(P. 143)
amount.

No Media No media is loaded, or the Load the media. & "Loading the

Media"(P. 61)

Clean the media sensor. (&~ "Media
Sensor Cleaning"(P. 132)
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Message

Cause

Corrective action

Please load media

+ Load the media. @& "Loading the

Media"(P. 61)

Media Undetected

The media width has not
been detected.

Detect the media width. (& "Loading
the Media"(P. 61)

Wiper Move Failure

The wiper is not operating
correctly.

Clean the wiper and around the wiper. (&
"Wiper Cleaning"(P. 126)

Turn off the main power and wait a while
before turning back on. (&&” "Turning Off the
Power"(P. 34)

Replace Wasteinktank

The waste ink tank count
exceeded the specified
value (90%), disabling the
automatic maintenance
function.

Check Waste Ink tank

The waste ink tank count
exceeded the preset
value (80%).

Check the waste ink levels in the waste ink
tank. (& "When "Check Waste Ink Tank"
message appears"(P. 158)

Replace the waste ink tank, then reset the
waste ink level. (%" "Replacing the lower-
left waste ink tank"(P. 158)

WashLiquidCart.None

No maintenance liquid
cartridge is loaded.

Load the maintenance liquid cartridge.

Please replace wash liquid
cartridge

Washing liquid end

The maintenance liquid
has run out.

Replace with a new maintenance liquid
cartridge.

High ambient temp **° C

Ambient temperatures are
too high.

Low ambient temp **° C

Ambient temperatures are
too low.

Adjust ambient temperatures to
temperatures within the specified range.
Optimum print quality may not be
possible unless ambient conditions are
within the specified range. (&~
"Installation Precautions"(P. 16)

Auto-correction failed

White media is not used.
The media is dirty.

The media lifts up.
There is dirt around the
sensor.

Load white and clean media.

Load media so it does not lift up.

Clean the area around the sensor. (&
"DAS (Automatic Correction Function)
Sensor Cleaning"(P. 129)

If automatic correction fails repeatedly,
correct the position manually. (25 "Feed
Correction"(P. 97) (& "Correcting the
Drop Position"(P. 99)

Take-Up LimitDetect

The take-up tension bar
was detected at the upper
limit position.

Lower the take-up tension bar.

Feeding LimitDetect

The feeding tension bar
was detected at the upper
limit position.

Lower the feeding tension bar.

Take-up Wrong

The take-up tension bar
has not moved from the
lower limit position.

Press () to feed the media and confirm
that the take-up unit operates correctly.

Feeding Wrong

The feeding tension bar
has not moved from the
lower limit position.

Press (¥ to feed the media and confirm
that the feeding unit operates correctly.

No Platen

No platens are mounted
on the machine.

Attach the platens, then print. (&~
"Platen"(P. 26)
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Message

Cause

Corrective action

Check Direct-Connection Unit

* Installation of the direct-
connection unit/torque
limiter does not match the
tension bar setting.

* When using tension bars, attach a
direct-connection unit, or otherwise
attach a torque limiter.

Message Cause Corrective action
Ink End « The ink has run out. + Replace with new ink. & "When Ink
End is Displayed"(P. 41)
» If you use UISS, you may perform
cleaning.
Ink Near End * Ink levels are low. * The ink will run out soon. Have new ink
ready. (& "When Ink Near End is
Displayed"(P. 41)

Non Ink IC + Noink IC chip was 1. Insert the ink IC chip.(&” "Replacing
detected. Ink"(P. 42)

2. Check to confirm the ink IC chip was
inserted correctly. (" "Mounting the
ink"(P. 45)

3. Turn off the main power and wait a while
before turning back on. (2" "Turning Off the
Power"(P. 34)

Wrong Ink IC  An error occurred with the | 1. Check to confirm the ink IC chip was
information on the ink IC inserted correctly. (& "Mounting the
chip. ink"(P. 45)

2. Turn off the main power and wait a while
before turning back on. (&&” "Turning Off the
Power"(P. 34)

3. Replace with new ink. (& "Replacing
Ink"(P. 42)

Ink Color » The ink color registered  Insert an ink IC chip for the correct ink
on the IC chip is different color. & "Mounting the ink"(P. 45)
from the ink color filled.

Ink Type * The ink type registered on | « Insert an ink IC chip for the correct ink
the IC chip is different type. & "Mounting the ink"(P. 45)
from the ink type filled.

Expiration Near » The ink has expired. * Replace with new ink or use up as

« The ink is one month past quickly as possible. Printing is possible.
its expiration date. (& "When Ink End is Displayed"(P. 41)

Expiration Over * The ink is two months * Replace with new ink. Printing is not
past its expiration date possible. (&5 "When Ink End is
and cannot be used. Displayed"(P. 41)
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Error Message

Error Message Cause Corrective action

number

04 PARAM ROM * A problem was detected * Turn off the main power and wait a
with the main PCB. while before turning back on. &~

108  |HD CONNECT[12] - A problem was detected Turning Off the Power'(P. 34)
with the print head
connection.

108 HD MEM EMP[12] * A problem was detected
with the print head.

10e FROM CLEAR * A problem was detected

10f FROM WRITE with the main PCB.

115 PCB MAIN-F1
122 CHECK:SDRAM * A problem was detected
122 PRAM NONE with the SDRAM.

123 PRAM DATA * A problem was detected
124 PRAM ADDR with the main PCB.

127 POWER OFF

128 HDC FIFO OVER/ * A problem was detected
HDC FIFO UNDER with the print head control

PCB.

129 Battery Exchange » The internal clock battery » Contact your local dealer or our
is spent and must be service office.
replaced.

12a HDC SPEED * A problem was detected * Turn off the main power and wait a
with the print head control. while before turning back on. (&~

12d  |PCB MAIN-F4 « A problem was detected Turning Off the Power'(P. 34)
with the main PCB.

130 HD DATA SEQ * A problem was detected
with the print head control.

147 DS-IC BUSY ¢ Ink IC control abnormality
detected.

148 E-LOG SEQ * A log control abnormality
was detected.

151 Main PCB V1R2 * A problem was detected

with the main PCB power

152 Main PCB V2R5 o
supply circuit.

153 Main PCB V3R3
154 Main PCB V05
155 Main PCB V42-1

15f HEAD DRIVE HOT « The HDCE PCB COM
driver is hot.

171 NEW HEAD CONNECT | < A new print head
connection was detected.

186 HDC OVERFLOW/HDC | < A problem was detected
UNDERFLOW with the print head control.
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Error Message Cause Corrective action

number

187 HDC SLEW RATE

188 HDC MEMORY

18c Main PCB V12 A problem was detected
with the main PCB power
supply circuit.

18e FLS NOT COMP A problem was detected

18f OFFSET START / END with the print head control.

[12]

1b5 SLIDER CONNECT The HDCE PCB could not | * Turn off the main power and wait a
be detected. while before turning back on. (&~

1bf PCB MAIN-F2 A problem was detected Turning Off the Power'(P. 34)
with the main PCB.

1d8 HEAD XHOT[12] A problem was detected
with the print head.

1e6 PRAM Size Shortage Insufficient memory

201 Command Error Data other than print (RIP) | 1. Clear the data and resend.
data was received, or a 2. Check the USB/Ether cable connection.
problem was detected (%" "Connecting a PC to the
with the print (RIP) data Product"(P. 36)
received. 3. Use a compatible cable. (&5

202 Parameter Error A problem was detected Connecting a PC to the Product’(P. 36)
with the print (RIP) data 4. Turn off the main power and wait a
received. while before turning back on. (&&°

"Turning Off the Power"(P. 34)

206 Print Mode Error Print (RIP) data was * Change the output parameters and
received with print profile using RIP software.
parameters that do not
allow printing.

20A Driver Version Printing is not possible « Install the latest Mimaki driver
because the Mimaki driver available from:
version is old. https://mimaki.com/download/

inkjet.html

303 PCB MAIN ET A problem was detected * Turn off the main power and wait a
with the main PCB. while before turning back on. (&

"Turning Off the Power"(P. 34)

304 USB INIT ERR A problem was detected 1. Check the USB cable connection. (&~
with the USB cable "Using a USB Cable"(P. 37)

305 USB TIME OUT connection. 2. Use a compatible cable. %&” "Using a

USB Cable"(P. 37)
3. Turn off the main power and wait a
while before turning back on. (&
"Turning Off the Power"(P. 34)
318 SDcard Connection A problem was detected |1. Turn off the main power and wait a
ERR with the SD card. while before turning back on. &~
"Turning Off the Power"(P. 34)

401 Motor X The X motor was 1. Check to confirm the media is loaded

overloaded. correctly. (” "Loading the
Media"(P. 61)

402 Motor Y The Y motor was

overloaded.
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Error Message Cause Corrective action

number

403 X Current An overcurrent error was Open the front cover and check for
detected in the X motor. anything that may obstruct carriage

movement.

404 Y Current An overcurrent error was . .
detected in the Y t Turn off the main power and wait a

etected in the ¥ motor. while before turning back on. (&~
"Turning Off the Power"(P. 34)

406 Wiper Move Failure The wiper origin could not Clean the wiper and around the wiper.
be detected. (% "Wiper Cleaning"(P. 126)

Turn off the main power and wait a
while before turning back on. (&~
"Turning Off the Power"(P. 34)

423 Take-up tension bar Take-up tension bar Lower the take-up tension bar.
pqsition initialization Check which way the take-up unit
failed. rotation direction switch is set. (2

"Take-up unit"(P. 62)
Check to confirm the media is loaded
correctly.

424 Feed tension bar Feeding tension bar Lower the feeding tension bar.
position initialization Check which way the feeding unit
failed. rotation direction switch is set. (25~

"Feeding unit"(P. 70)
Check to confirm the media is loaded
correctly.

425 Take-up Wrong The take-up tension bar Check which way the take-up unit
has not moved from the rotation direction switch is set.
lower limit position. Check to confirm the media is loaded

correctly.

426 Feeding Wrong The feeding tension bar Check which way the feeding unit
has not moved from the rotation direction switch is set.
lower limit position. Check to confirm the media is loaded

correctly.

429 Take-Up LimitDetect The take-up tension bar Lower the take-up tension bar.
was detected at the upper Check which way the take-up unit
limit position. rotation direction switch is set. (25

"Take-up unit"(P. 62)
Check to confirm the media is loaded
correctly.

42a Feeding LimitDetect The feeding tension bar Lower the feeding tension bar.
was detected at the upper Check which way the feeding unit
limit position. rotation direction switch is set. (&~

"Feeding unit"(P. 70)
Check to confirm the media is loaded
correctly.

44f Take-up Roll Sns Err A problem was detected Check to confirm the [Function Setting]

with the take-up unit
sensor spindle.

> [Option Roll Unit Select] > [Take-up
Unit] setting is "ON".(&&” "Function
Setting Menu"(P. 116)

Check to confirm the media is loaded
correctly. (22” "Loading Rolls of Cloth
Media"(P. 71)

Check to confirm the take-up unit switch
functions properly. (& "Take-up
unit'(P. 62)
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Error Message Cause Corrective action
number
450 Feeding Roll Sns Err * A problem was detected 1. Check to confirm the [Function Setting]
with the feeding unit > [Option Roll Unit Select] > [Feeding
sensor spindle. Unit] setting is "ON".(2&> "Function
Setting Menu"(P. 116)

2. Check to confirm the media is loaded
correctly. (&&” "Loading Rolls of Cloth
Media"(P. 71)

3. Check to confirm the feeding unit switch
functions properly. & "Feeding
unit"(P. 70)

48b Y MOTOR COM * Y motor communication is Turn off the main power and wait a
not possible. while before turning back on. &

48c Y MTR 12C COM * 'Y motor communication is Turning Off the Power'(P. 34)
not possible at startup.

496 Y MOTOR DIR » The Y motor operating
direction cannot be
specified.

504 CLAMP UP * The clamp lever is lifted. Lower the clamp lever.

505 Media Jam * The media jam sensor 1. Remove the media in contact with the
was triggered. carriage and reload with fresh media.

(& "Loading the Media"(P. 61)

2. Open the front cover and check for
anything that may obstruct carriage
movement.

507 HEADHEIGHT ERR * A problem was detected in Turn off the main power and wait a
head height (Low to High) while before turning back on. &°
acquisition. "Turning Off the Power"(P. 34)
509 HDC POSCNT * A problem was detected Turn off the main power and wait a
with position control. while before turning back on. (&~
50a Y Org Detect Error * A problem was detected Turning Off the Power'(P. 34)
with Y origin detection
(initialization).
50c Check Media With - A problem was detected | 1. Check the media loading position. (25
Sensor with media width "Loading the Media"(P. 61)
detection. 2. Clean the media width sensor. (&&°
"Media Sensor Cleaning"(P. 132)
50f L-SCALE BLACK » A problem was detected Turn off the main power and wait a
with the linear scale. while before turning back on. (&
"Turning Off the Power"(P. 34)
516  |Media Set Positon R | + The media was loaded ~ |1. Check the media loading position. (&~
(L) outside the range of valid "Loading the Media"(P. 61)
positions. 2. Clean the media width sensor. (&
"Media Sensor Cleaning"(P. 132)
530 Station Origin » The station control origin Contact your local dealer or our
is not set. service office.
54c Vacuum Fan Err * A problem was detected Turn off the main power and wait a
with the vacuum fan. while before turning back on. (&~
54d  |HDCE Cooling Fan Err | + An HDCE cooling fan Turning Off the Power'(P. 34)
rotation abnormality was
detected.
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Error Message Cause Corrective action
number
602 Ink End * The ink has run out. + Replace with new ink. & "When
Ink End is Displayed"(P. 41)
608 Wrong Ink IC * An error occurred with the | 1. Check to confirm the ink IC chip was
information on the ink IC inserted correctly. & "Mounting the
chip. ink"(P. 45)
2. Turn off the main power and wait a
while before turning back on. (&~
"Turning Off the Power"(P. 34)
3. Replace with new ink. (& "Replacing
Ink"(P. 42)
60a Excess Ink Usage » The ink usage amount + Replace with new ink. &~ "When
stored in the ink IC chip Ink End is Displayed"(P. 41)
exceeded the preset
value.
* The ink IC chip was not
replaced during ink
replacement. (The same
chip continued to be
used.)
60c Ink Type » The ink type registered on | < Insert an ink IC chip for the correct
the IC chip is different ink type. &” "Mounting the
from the ink type filled. ink"(P. 45)
629 Expiration Near » The ink has expired. » Replace with new ink or use up as
« The ink is one month past quickly as possible. Printing is
its expiration date. possible. & "When Ink End is
Displayed"(P. 41)
62a Expiration Over * The ink is two months * Replace with new ink. Printing is not
past its expiration date possible. & "When Ink End is
and cannot be used. Displayed"(P. 41)
631 Ink Color * The ink color registered  Insert an ink IC chip for the correct
on the IC chip is different ink color. @& "Mounting the
from the ink color filled. ink"(P. 45)
637 INK LEAK _ * The ink leak sensor » Contact your local dealer or our
detected an ink leak. service office.
801 (C) OPCODE * A problem was detected * Turn off the main power and wait a
with the main PCB. while before turning back on. &~
802 (C) SWi "Turning Off the Power"(P. 34)
803 (C)PFTCHABRT
804 (C)DATAABRT
806 FWI/SIO bit * A communication error
was detected between the
boards.
808 FW/STP-MTR** * A problem was detected
with the main PCB.
80f FW/SIO Vch * A communication error
was detected between the
boards.
811 FWI/SIO read **** * A communication error
was detected between the
boards.
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Error Message Cause Corrective action
number
81b FW/STACK OV A problem was detected
828 PRG ERR L with the main PCB.
901 Operation Error The function is disabled Check the error details.
due to an error.
902 Data Remain Print (RIP) data was Switch to REMOTE mode and start
received. printing or clear the data and abort
printing.
90f Print Area Short The media is too small for Replace with wider or longer media.
the print. If the printable area is reduced due
to a shift in the origin, move the
origin to increase the size of the
printable area.
b1a PCB BaselO1 A communication error Turn off the main power and wait a
was detected between the while before turning back on. (&~
boards. "Turning Off the Power"(P. 34)
b1b BaselO PCB Vpow-s A problem was detected
blc BaselO PCB V24 with the Base IO PCB
power supply.
b1e PCB BaselO-F** The Base 10 PCB fuse The fuse must be replaced. Contact
blow was detected. your local dealer or our service
office.
b36 PCB INKIO A communication error Turn off the main power and wait a
was detected between the while before turning back on. (&
boards. "Turning Off the Power"(P. 34)
b3f BaselO Unconform The PCB could not be
detected.
b48 PCB HDCE* A communication error
was detected between the
boards.
b49 PCB HDCE- A problem was detected
VHVFET[12] with the HDCE PCB
power supply.
bda PCB HDCE*-F* A blown fuse on the Contact your local dealer or our
HDCE PCB was detected. service office.
b4b HDCE* PCB V1R2 A problem was detected Turn off the main power and wait a
N with the HDCE PCB while before turning back on. &~
béc HDCE" PCB V2R5 power supply. "Turning Off the Power"(P. 34)
b4d HDCE* PCB V3R3
b51 BaselO PCB V24ad] A problem was detected
with the Base |O PCB
power supply.
d1b COM VOLT[12] A problem was detected
with the HDCE PCB
voltage.
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SYSTEM HALT

0 « Ifa SYSTEM HALT number is displayed, turn off the main power and wait a while before turning

back on.
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Chapter 6 Appendix

6.1 Specifications

Item Tx330-1800
Print Type On-demand piezo head
head Specifications Two staggered heads with 400 nozzles x 8 rows each
Resoluti | Y 300 dpi, 600 dpi
on X 600 dpi, 900 dpi, 1,200 dpi, 1,800 dpi
Ink Type Sb420, Sb411, TP410
Ink set | Sb420 4-color: M, BI, Y, K
6-color: C, M, Bl, Y, K, Lb, Lm
TP410 4-color: M, C, Y, K
8-color: M, C, Y, K, R, G, BI, Lk
Hybrid Sb411: M, Bl, Y, K/ TP410: M, C, Y, K
Sb420: M, BI, Y, K/ TP410: M, C, Y, K
Sb411: M, B, Y, K/ Sb420: M, BI, Y, K
Media |Type Decalcomania paper, fabric
Maximum printing | 1,940 mm (decalcomania paper), 1,910 mm (fabric)
width "
Maximum width 1,950 mm (decalcomania paper), 1,920 mm (fabric)
Minimum width 210 mm
Thickness Max. 5.0 mm
Roll external Max. 250 mm
diameter 2
Roll weight % | Max. 40 kg
Paper core 2 inches or 3 inches
internal diameter
Printing face Exterior/interior
Roll end Taped or loosely affixed to paper core
Print Left/right 15 mm (default), minimum: 5 mm
margins
Distanc | Absolute 0.3 mm or 0.3 % of specified distance, whichever is greater
e accuracy
j&curac Duplicability 1+0.2 mm or 0.1 % of specified distance, whichever is greater
Perpendicularity 0.5 mm/1,000 mm
Media skew Not more than 5 mm/10 m
Printing gap Manual, five settings (3.0-7.0 mm)
Origin alignment LED pointer
Ink supply Ink eco-case (ink pack)
Maintenance liquid feed Cartridge
Waste Ink Tank Bottle type (2,000 ml x 2)
Take-up unit Provided
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Item Tx330-1800
Feeding unit Provided
Media heater -
NCU (Nozzle clogging Provided
detection)
DAS (Automatic correction |Provided

function)

Interfac | Data transfer Ethernet 1000BASE-T (recommended) >, USB 2.0 Hi-speed '
e function
Command MRL-V
Languages English, Japanese, Chinese, Turkish, Portuguese, Spanish, ltalian, Korean
Noise During standby Not more than 54 dB (FAST-A, 1 m on all sides)
levels Continuous Not more than 59 dB (FAST-A, 1 m on all sides)
operation

Non-continuous
operation

Not more than 65 dB (FAST-A, 1 m on all sides)

Compliance with standards

VCCI Class A, FCC Class A, IEC 62368-1 ETL compliance, CE marking
(EMC Directive, Low Voltage Directive, Machinery Directive, RoHS Directive),
CB certified, REACH, EnergyStar, RCM marking, KC certified, UKCA marking

Power supply

Single-phase 100 to 120V AC / 200 to 240 V AC 10 %/3 A,

specifications © 50/60 Hz 1 Hz
Power | Maximum 2 300 W or less
consum
ption Standard 170 W
Minimum_ 19 4.5 W orless
Installati | Permissible 20to 30 °C
on ambient
environ |temperature
*11
ment Relative humidity |35 to 65 %RH (no condensation)
Temperature 20to 25 °C
range in which
accuracy is
guaranteed
Temperature Not more than £10 °C/h
gradient
Dust 0.15 mg/m® (typical office)
Maximum 2,000 m
operating altitude
External | Width 3,230 mm (3,590 mm)
dimenst bepth 965 mm (1,010 mm)
ons
Height 1,857 mm (1,165 mm)
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Item Tx330-1800

Weight 12 291 kg (394 kg)

*1. With setup menu margins set to the minimum (5 mm) on either side.

*2. External diameter and weight after winding media.

*3. Free of sagging due to weight.

*4. Excluding media size variation and initial loading fluctuations.

*5. Printing is not possible if local guidance shows any speed other than "1000Mbps". Using a LAN Cable

*6. The print speed may be decreased depending on the connection environment or print data. Connecting a
PC to the Product

*7. Data may be transferred to the machine too slowly, causing the carriage to pause at the left-hand or right-
hand end during printing.

*8. Excluding options.

*9. Varies depending on print mode.

*10. In sleep.

*11. Ink ejection consistency may decrease in conditions outside this range.
*12. The figures in parentheses indicate package dimensions.
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6.2 Options

Name Code Reference
Small Relay Box OPT-J0370
Relay Box 2 OPT-J0407
Slip Sheet Holder Unit OPT-J0405
1-inch Holder Unit OPT-J0399
OPT-DsubBKT OPT-01012
Slip Sheet Unit Mounting BKT OPT-01013
Drying Fan Connection Kit OPT-J0512

Relay Box

+ A fire may occur if another manufacturer's external drying heater is used. Be sure to connect to
the machine using either the compact relay box or relay box 2 specified as options.

* The Tx330-1800 allows only one relay box (OPT-J0370 or OPT-J0407) to be connected.

\Q/ » The optional connection relay cable (OPT-J0512 drying fan connection kit) and the mounting

- bracket (OPT-01012 OPT-DsubBKT) are required when using a relay box.

® Overview

The relay box switches the heater power on and off automatically in conjunction with the machine
operations.

» The heater is turned off when printing stops to prevent heating while the machine is not moving.

» The relay box cannot function to control the temperature of an external drying heater. The temperature
should be set on the external heater itself.

® Specifications

Small relay box (OPT-J0370) Power | Single-phase 100 V to 120 V AC, 12 A, single-phase
supply 200 V to 240 V AC, 8 A, 50/60 Hz, single-circuit main

specificatio | power supply
ns

Type Resistance heater or electric heater using lamp

Power | Single-phase 100 V to 240 V AC, 30 A, 50/60 Hz,
supply |single-circuit main power supply
specificatio
ns

Type Resistance heater or electric heater using lamp
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